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PO-Purchasing 

The Integrated System's Purchasing module, allows you to create requisitions, add/view 
supplier/vendor information, work purchase orders, and reimburse or pay suppliers/vendors 
directly (Payment Voucher) based on your responsibility, which include the following:  

• PO Shopper - Individuals who enter purchase requisitions and place orders using the 
UVa Marketplace and are able to access and update receiving in iProcurement. Note: 
Shopper responsibilities do not require a UVa Identity Token. 

  

o PO Shopper-$1 - Every requisition created by these shoppers will 

route to their departmental approver for approval.  

  

o PO Shopper>$1 - These individuals have a set dollar amount for 

approval authority. However, any requisition created for a dollar 

amount higher than their dollar limit will route to their departmental 

approver for approval.  

  

• PO Requester -Individuals have the same level of access as PO Shoppers, and 
additionally are able to view Purchase Order (PO) information, and run reports in the 
Integrated System.  

  

• PO Purchaser - Individuals have the same level of access as PO Shoppers and 
Requesters, and additionally are able to initiate and approve payment vouchers and 
view Accounts Payable information.    

  

• PO Approver -Individuals have the authority to approve purchase requisitions 
entered into the Integrated System. This responsibility does not enter requisitions or 
order goods/services in the UVa Marketplace. They review items requiring their 
approval via email notification or within the Integrated System. PO Approvers are able 
to open and view notifications, access the Edit Requisition and View Requisition Details 

links, and are able to review and/or update requisitions before approval.  

  

• AP/PO Viewer - Individuals have access to view information in the Purchasing and 
Accounts Payable modules in the Integrated System. This responsibility is 

automatically granted with several AP and PO responsibilities. Training is not required, 
but the online classes "Navigating the FIN/HR System-IS" and "AP - Viewing AP and 
PO Information" are highly recommended.       
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After completing this course, online help 
(http://www.virginia.edu/integratedsystem/gettingStarted/Using_Online_Help_Quick_Guide.p
df) is available within the Integrated System and the printed guide can be found in the toolkit 
(http://www.hr.virginia.edu/other-hr-services/employee-development/sys/po_ap-tk/) for the 

module. 

  

At the completion of this module, depending on your responsibility and the needs of your 
department, you will be able to:  

• Access the UVa Marketplace and set Preferences (iProcurement) 

• Shop in the UVa Marketplace 

• Troubleshoot Approvals 

• Work with Favorites in the UVa Marketplace   

• View, Change, or Cancel Requisitions       

• Correct an Invalid GL Date (iProcurement) 

• Troubleshoot requisitions       

• View and print purchase orders from the UVa Marketplace       

• Record the receipt of goods/services (iProcurement) 

• Find and/or enter Suppliers/Vendors in the Integrated System (IS)     

• Find, view, and print purchase orders (IS)    

• Change and cancel purchase orders (IS) 

• Control purchase orders (IS)       

• Process receipt of goods/services (IS)     

• Create a Payment Voucher (IS) 

• View the status of a Payment Voucher (IS) 

• Change and resubmit a Payment Voucher (IS) 

• Delete or cancel a Payment Voucher (IS) 

• Save a Document to the Navigator 

Introduction to the UVA Marketplace 

UVA Marketplace Overview  

  

  

The UVA Marketplace is where users shop for products, manage favorites, and print purchase orders. Users 

access the UVA Marketplace via an icon found in iProcurement. The UVA Marketplace has three main 

areas -- the main workspace, the top banner, and the side navigation menu.  These areas will be further 

discussed in upcoming lessons. 

  

Upon completion of this section, you will be able to: 

• Access the UVA Marketplace 

• Set up preferences in iProcurement 

• Navigate the UVA Marketplace 

• Review vendors in the UVA Marketplace 

• Identify icons and helpful tips 

• Browse by Supplier and Category 

• Complete an Advanced Search for products 

http://www.virginia.edu/integratedsystem/gettingStarted/Using_Online_Help_Quick_Guide.pdf
http://www.virginia.edu/integratedsystem/gettingStarted/Using_Online_Help_Quick_Guide.pdf
http://www.hr.virginia.edu/other-hr-services/employee-development/sys/po_ap-tk/
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Accessing the UVA Marketplace 

Procedure 

 
IMPORTANT information about this training:  You should only use the "Try It" mode to 

take this training.   "Try It" mode allows you to experience the interactive training and 

actual simulations of the activities you will be doing in the Integrated System and the UVA 

Marketplace.   

 

In this section you will learn how to access the UVA Marketplace in the Integrated System. 

 

While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 

 
 

Step Action 

1. If your responsibility requires a Joint VPN sign in, click on the Integrated System 

HR/Finance Admin button. 

 

If your responsibility does not require Joint VPN sign in, you would access the 

Marketplace through the Employee/Manager Self-Service button. 

 

For this example, click on the Integrated System HR/Finance Admin button. 
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Step Action 

2. This is where you will enter your Username and Password.  For this training, you do 

not need to enter anything. 

 

Click on the Login button. 
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Step Action 

3. Click on the UVA PO Purchaser link. 

 

The other responsibilities that can access the UVA Marketplace are UVA PO 

Shopper or UVA PO Requester.   

 

4. Click on the UVA Marketplace link. 

 

 

 
 

Step Action 

5. Click on the UVA Marketplace link. 

 

6. Congratulations!  You have completed the section on Accessing the UVA 

Marketplace. 

End of Procedure. 

Setting up Preferences in iProcurement 

Procedure 
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In this section you will learn how to set up preferences in iProcurement that will default 

when you make your purchases.  You can set up preferences for the Requester's Name, 

Deliver-To Location, and you can enter as many as 50 different PTAEOs.  Only the PTAEO 

that is set as the primary PTAEO will default, but can be changed upon checkout. 

 

Note:  All users MUST set their Deliver-To Location Code in Preferences before ordering in 

the Marketplace. 

 

While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 

 
 

Step Action 

1. Click on the UVA PO Shopper link. 
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Step Action 

2. Click on the Settings icon. 

 

3. Click on the Preferences link. 
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Step Action 

4. Click on the iProcurement Preferences link. 

 

5. The first time you enter preferences you will have to enter the requester name (your 

name or whoever you want to default as the requester.) 

 

 
 

Step Action 

6. The Requester name has been entered for you. 

 

The Deliver-To Location (DLC) defaults every time you create a requisition. DO 

NOT leave HR-University of VA as the DLC.  Click on the Look Up icon to 

search the list of values for your DLC. 

 

If your DLC does not exist, or if you need to update or delete an existing DLC, then 

submit a Delivery Location Request form (found on the Procurement Services web 

site).  

 

For this example, search for the Deliver-To Location information. Enter "BD". 
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Step Action 

7. Press [Tab]. 
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Step Action 

8. Select the appropriate DLC. 

 

Click the Quick Select button for BDBROD. 

 

 

 
 

Step Action 

9. Click on the Add PTAEO icon. 
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Step Action 

10. Note:  When you enter data into the fields, press the [Tab] key to move to the next 

field.  However for this simulation, you will move to the next field automatically 

after entering the data. 

 

The nickname field is a free form field which you can use to help identify specific 

PTAEOs.   

 

For this example, enter "LAB 1" in the nickname field.  

11. Enter the desired information into the Project field.  

 

Enter "101902". 

 

You can also choose the Project from the list of values by clicking on the 

magnifying glass icon. 

12. Enter the desired information into the Task field.  

 

Enter "101". 

 

You can also choose the Task from the list of values by clicking on the magnifying 

glass icon. 

13. Enter the desired information into the Award field.  

 

Enter "LG00005". 

 

You can also choose the Award from the list of values by clicking on the 

magnifying glass icon. 
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Step Action 

14. You can also choose the Expenditure Type from the list of values by clicking on 

the magnifying glass icon. 

 

Although you can set the Expenditure Type in your preferences, you should always 

ensure that your purchases and requisitions have the correct expenditure type during 

checkout. 

 

For this example, we will leave the expenditure type field blank. It is a required field 

that you will enter during checkout. 

15. Enter the desired information into the Expenditure Org field.  

 

Enter "31680". 

 

You can also choose your organization from the list of values by clicking on the 

magnifying glass icon. 

 

 
 

Step Action 

16. You can add as many as 50 PTAEOs to your preferences, but one must be set as the 

primary PTAEO.   

 

To do so, click on the Select radio button (to the left of the Nickname field.) 

 



 

Training Guide 
 

 

 Page 13 

Step Action 

17. Click on the Set as Primary button. 

 

18. If you would like to add more favorite PTAEOs, click on the Add PTAEO icon.  

 

The primary PTAEO will default when you submit your purchases.  You can change 

which PTAEO defaults as the primary by selecting the PTAEO and clicking on the 

Set as Primary button. 

 

 
 

Step Action 

19. Click on the Apply button. 

 

20. Notice the Confirmation message at the top of the screen.  Preferences will be 

available when you submit your purchases and every time you log in to 

iProcurement. 

21. Congratulations!  You have completed the section on setting up preferences in 

iProcurement. 

End of Procedure. 

Navigating the UVA Marketplace 
1. Top Banner - Preview and manage the list of items in your active cart and perform 

a quick search 
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2. Side Navigation Bar - Contains two menus; Shop and Orders & Documents. 

• Shop Menu (Shopping) 

Search for products and place items into a cart.  

View your Favorites folder.  

Access forms such as the Non-Catalog Item and Quick Order.  

Browse By Suppliers, Categories, and Contracts. 
  

• Shop Menu (My Carts and Orders) 

View the active and draft carts, and your most recent orders. 
  

• Orders & Documents 

Search for purchase orders and print them. 
  

3. Main Workspace - The main workspace changes as you access other areas of the 

application. 
  

• Search for Hosted Catalogs items. 

• Read the Welcome message. 

• Suppliers grouped by Minority, External, or Commodity. 

• Access to Searches, Favorites, Non-Catalog and Quick Order forms 

• Browse by Supplier, Categories, and Contracts 

• Links to searches for UVA Purchasing Forms & Contracts 

• Exit the UVa Marketplace link 

Procedure 

 
In this section you will learn how to navigate the UVA Marketplace. 

 

 

Step Action 

1. There are three main areas of the user interface; the main workspace, the top banner, 

and the side navigation menu.  

 

As you access other areas of the application, only the main workspace changes. The 

top banner and side navigation menu remain in place. 
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Step Action 

2. Top Banner 

 

The top banner (blue bar at the top) includes your name (with a submenu), a star 

icon, an Action Items flag icon, a Notifications bell icon, a cart preview, and a 

search field.  

 

UVA does not use the Action Items or Notifications icons. 

 

A drop-down arrow beside your name indicates that you can select it to access the 

submenu.  

 

Click either the drop-down icon or your name (link) to access the submenu.  

 

3. There are two ways to log out of the application. Use either the Exit the UVA 

Marketplace link found on this menu or a button located directly on the main 

workspace, which you will see later.  

 

Note: You do not need to update your user profile.  
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Step Action 

4. Cart Preview allows you to get a quick view of the active shopping cart without 

having to access the cart in the application.  

 

From Cart Preview you can review the item list, delete an item from the cart 

(trashcan), and access the active cart.  

 

Click the Cart Preview link. 

 

 

 
 

Step Action 

5. The View My Cart button not only allows access to the active cart but you can also 

make changes and return the cart to the Integrated System here. This is the most 

popular choice. 

 

Checkout contains General and Final Review information. Note: You may also 

complete the cart here. 
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Step Action 

6. The top banner provides the ability to perform a quick search of the site. 

 

Click the Quick Search button. 
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Step Action 

7. You may search for a Contract or a specific Purchase Order Number. 

 

When selecting the All option, you can search by keywords among all users, tasks, 

suppliers, and other items available for search. 

 

You can also access Quick Search using the quick-access key combination Alt + Q 

from anywhere in the application. 

 

Note: It is not advisable to search by Requisition Number as this number does not 

correlate with the Integrated System requisition number. 

 

 
 

Step Action 

8. Side Navigation Bar 

 

The side navigation bar is located on the left side of the workspace. It contains the 

top-level menu items; some of which are accessible from the workspace (below the 

Shop Hosted Catalogs search).  

 

When you roll over the main menu icons, slide-out sub-menus display. Menus are 

grouped by related tasks. Shopping tasks are grouped in the Shop menu, and 

document search tasks are grouped in the Orders & Documents menu.  

9. Clicking on the Home icon will return you to the homepage from anywhere in the 

application. 
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Step Action 

10. The Shop menu contains menu options relating to shopping tasks, including product 

quick search, access to the shopping page, favorites, and access to carts and orders.  

 

Click the Shop (cart) menu icon. 
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Step Action 

11. The Shopping sub-menu allows you to perform a simple search by keyword, catalog 

or CAS number.  

 

Note: Clicking Alt + P also allows access to the product search. 

12. The Shopping sub-menu also allows you to continue shopping through the shopping 

home, perform an advanced search, view your favorites, view forms, and create a 

Non-Catalog Item or Quick Order from the Go To sub-menu.  

 

You can Browse By Suppliers, Categories, and Contracts as well. 

13. Click the My Carts and Orders link to view the sub-menu.  
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Step Action 

14. The My Carts and Orders menu contains options for viewing your active cart, 

draft shopping carts, and your most recent orders. 

15. Menu items related to Document Search are located in the Orders & Documents 

menu. 

 

Click the Orders & Documents icon. 
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Step Action 

16. You may Search Documents and View Saved Searches from this menu. 

 

Click the Search Documents link. 
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Step Action 

17. Search by a Purchase Order Number and a Date Range, or perform an advanced 

search. You may view all of your purchase orders by selecting the link "my 

purchase orders". 

18. UVA is currently not using the Reporting icon.  

19. You can use the Menu Search feature (searching by keyword) to find a list of pages 

containing the keyword. Search results will take you directly to that page.  

 

 
 

Step Action 

20. The search results display "breadcrumbs" that show you the path to the menu item. 

 

Note: Use the quick-access key combination of Alt + M anywhere in the application 

to access the Menu Search. 

21. Clicking the Exit UVA Marketplace button is an easy way to exit the application. 

22. Congratulations!  You have completed the section on how to navigate the UVA 

Marketplace.  

End of Procedure. 

Understanding Vendors in the UVA Marketplace 

Procedure 

 
In this section you will learn about the different types of vendors and catalogs in the UVA 

Marketplace. 
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While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 

 
 

Step Action 

1. Vendors 

 

There are several types of Vendors in the UVA Marketplace. 

 

Catalog Vendors are vendors whom UVA has identified and who have agreed to 

have their catalogs loaded in the Marketplace.  There are two types of catalogs:  

Hosted and Punchout. 

 

Non-Catalog Vendors:  Vendors who are in the Marketplace, but for whom 

catalogs are not available.  Users will complete orders from non-catalog vendors 

using a Non-Catalog Item form.    
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Step Action 

2. Hosted Catalogs 

 

Hosted Catalogs are catalogs of products with UVA-negotiated prices that are 

hosted in the Marketplace.  Users will be able to search the Marketplace for 

products by description, category, or vendor, and compare products and 

prices.                  

 

You can search all of the Hosted Catalogs in the Marketplace for products by 

entering your search criteria and clicking on the Search button. You can also 

compare products and prices after you have executed your search.    

 

Note: This search will not return items from punch-out suppliers, non-catalog 

suppliers, or the web.  
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Step Action 

3. Punchout Catalogs 

 

Punchout Catalogs are catalogs of products with UVA-negotiated prices where 

users will punchout to the vendor's web site to search for and select products. 

 

Some icons on this page identify the vendor as either a Punchout or Hosted catalog 

vendor. For example, notice that America To Go is in the Punch-Out section, and 

Owens & Minor is identified as a punch-out vendor in the Lab Supplies Catalogs 

section. 

4. This page is organized by classification. There are sections for  Minority Catalog 

Suppliers, Punch-out Suppliers and External Website Suppliers.  Vendors are 

also grouped by commodity (Lab Supplies, Office/Computer, Furniture, and 

others).  

 

Note: The categories and vendors here may be different than what you will see in 

production. This page is maintained by Procurement and will change as needed.  

5. The Search UVA Purchasing Forms link takes you directly to the forms page on 

the Procurement & Supplier Diversity Services web site. 

 

The following forms can be found there: 

•Purchase Order Change Request 

•Purchasing Unit Request Form 

•Delivery Location Request Form 

•Sole Source Justification 

•Phone Quote Summary 
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Step Action 

6. The Search UVA Contracts link takes you directly to the contracts page on the 

Procurement & Supplier Diversity Services web site. 

 

 
 

Step Action 

7. Using the Non-Catalog Item form 

 

Use the Non-Catalog Item form to purchase from Non-Catalog Vendors. 

 

You can also use the Non-Catalog Item form to purchase from vendors with 

catalogs (hosted or punchout) in the Marketplace, to purchase a product that is not 

listed in their catalog. 

 

You select the vendor, complete the on-line form with the information required to 

complete the purchase, and add the product(s) to your shopping cart. 
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Step Action 

8. Click the suppliers link. 
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Step Action 

9. All vendors are identified by "Type" flags that show whether they have a hosted or 

a punchout catalog in the UVA Marketplace, or if they are a non-catalog vendor. 

 

Vendors are also identified with "Preference" flags that show if they are eVA-

Excluded, have an eVA-Registered site, a contract vendor, DMBE-Certified woman-

owned, minority-owned, or small business. 

 

 
 

Step Action 

10. Congratulations!  You have completed the section that describes the different 

types of vendors and catalogs in the UVA Marketplace. 

End of Procedure. 

Using Icons and Helpful Tips 

Procedure 

 
In this section you will learn about some of the icons and helpful tips you will see in the 

UVA Marketplace. 

 

While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 
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Step Action 

1. You can click on the name of the vendor to see specific information (address, phone 

number, catalog information, product categories, etc.) about the vendor. 

 

Click on the Quality Biological Inc. link. 
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Step Action 

2. Note that the vendor's preferences are listed here, but the icons are not shown.  You 

will also see how POs are delivered to the vendor here. 

 

POs are delivered to vendors one of four different ways: 

     - SciQuest* Will Deliver PO by FAX 

     - SciQuest Will Deliver PO by XML (sent electronically) 

     - SciQuest Will Deliver PO by eMail 

     - User Must Deliver PO 

*SciQuest is the company that manages catalogs for the UVA Marketplace. 

 

You will also see this information when you place your order and when you receive 

notification of your order.  Pay particular attention to this notification, so that you 

will know when you must deliver the PO, as it will vary by 

vendor.                                     

 

 
 

Step Action 

3. Vendors are flagged by icons in the Type and Preference columns.  A definition of 

each of the icons follows. 

 



Training Guide 

 
 

 

 Page 32 

 
 

Step Action 

4. Indicates a vendor with a Hosted catalog. 

 

 
 

Step Action 

5. Indicates a vendor with a Punchout Catalog. 
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Step Action 

6. Indicates a vendor that does not have a hosted or a punchout catalog.  To purchase 

from these vendors you must use the Non-Catalog Item form. 

 

 
 

Step Action 

7. Indicates a vendor that has at least one eVA-registered site. 
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Step Action 

8. Indicates a DMBE-certified minority-owned business. 
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Step Action 

9. Indicates a DMBE-certified small business. 

 

 
 

Step Action 

10. Indicates a DMBE-certified woman-owned business. 
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Step Action 

11. Indicates a Contract vendor. 

 

 
 

Step Action 

12. Indicates an eVA-excluded vendor. 
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Step Action 

13. You can click on any question mark to open a help window for that particular area. 

 

 
 

Step Action 

14. If you have added items to your cart, you can click on the cart icon at any time to 

view your cart. 
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Step Action 

15. You can click on Exit UVA Marketplace to return to iProcurement without 

checking out.  

 

If you have added items to your cart the cart will NOT be saved if you exit the 

Marketplace without checking out. 

16. Congratulations!  You have completed the section on the icons and helpful tips 

you will see in the UVA Marketplace. 

End of Procedure. 

Browsing by Supplier 

Procedure 

 
Browsing by supplier is helpful if you know the vendor's name and want to view their 

catalog or other information about the vendor.  You can also ensure that a vendor is in the 

vendor file by browsing by supplier. 

 

In this section you will learn how to browse the UVA Marketplace by supplier. 

 

While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 
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Step Action 

1. Click on the Browse: suppliers link. 

 

2. You can expand your search if you want to include punchout and other vendors. 

 

Click on the + Click to expand Search for Supplier Filter link. 

 

3. You may search by either Supplier (name) or Supplier Type. 
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Step Action 

4. Click the Supplier Type down arrow to view the list of different Supplier Type 

choices. 

 

5. When you choose "All", the search returns all suppliers/vendors in the vendor file, 

including Hosted, Punchout, and Non-catalog vendors. 

 

Press [Enter] to continue. 
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Step Action 

6. Click on the Search button. 

 

7. Click on the + Click to expand Search for Supplier Filter link.  
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Step Action 

8. You can also browse the supplier list by name.  Look for all vendors with "lab" in 

the name. 

 

Enter "lab" in the Supplier field. 

9. Click the Search button. 

 

10. You will get a list of all vendors with the word "lab" in the name. 

 

You can use the page arrow keys to go from one page to the next and back. 

11. Congratulations!  You have completed the section on browsing by supplier in 

the UVA Marketplace. 

End of Procedure. 

Browsing by Category 

Procedure 

 
Browsing by category is helpful if you are unsure of the vendor, or the specific product, and 

want to look at entire categories of products, and the vendors that supply them. 

 

In this section you will learn how to browse the UVA Marketplace by category. 

 

While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 
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Step Action 

1. In this example, you're going to look for paper products.  

 

Click on the Browse: categories link. 

 

2. Click on Office/Computer. 

 

 

 
 

Step Action 

3. Click on the Paper Materials and Products link to search for Office/Computer 

paper materials and products. 

 

4. Click on the view (incl. subcategories) link to search for paper products. 
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Step Action 

5. You will be able to use the Filter Results By Supplier section (left of the product 

results listing) to filter by supplier.    

 

Also note that you can click on the funnel with the green plus sign to filter by 

supplier. 

 

Click the DAYCON PRODUCTS COMPANY INC (36) link. 

 

6. You will be able to scroll down to find the product you want. 

7. Congratulations!  You have completed the section on browsing for products by 

category in the UVa Marketplace. 

End of Procedure. 

Using Advanced Search 

Procedure 

 
In this section you will learn how to use the Advanced Search option when searching for 

products in the UVA Marketplace. 

 

While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 
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Step Action 

1. Click on the advanced search link. 

 

2. You can enter information in any of the fields for the advanced search. 

 

Enter the desired information into the Part Number (SKU) field. Enter "8697S". 
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Step Action 

3. If you use the Supplier field in your advanced search, you can type part of the 

vendor's name and a list will appear of vendors that have the word or letters that you 

entered anywhere in the name. 

 

The list is sorted by best match, based on the way that UVA has flagged the 

vendors.  This means that contract, and DMBE-certified (minority or woman-

owned) vendors will appear first. 

 

If the list of vendors matching your search criteria is long, you will see "click here 

to view more supplier results", which will give you the complete list of vendors (it 

may be more than one page) with the vendor's sites listed. 

 

Enter "Cell" in the Supplier field. 

4. Click on Cell Signaling Technology Inc to select it from the list. 

 

5. Click on the Search button. 

 

6. You will see any products that meet the search criteria you entered in the Advanced 

Search fields. 

7. To return to the simple search view click on the simple search link. 

8. Congratulations!  You have completed the section on using the Advanced 

Search option when searching for products in the UVA Marketplace. 

End of Procedure. 

Shopping in the UVA Marketplace 

Guidelines for Competition 

  

Consult the Guidelines for Competition (http://www.procurement.virginia.edu/pageguidelinesforcomp) to 

determine if your purchase will require competition, or other processing by Procurement Services, or if 

your department may order it directly. 

  

  

Guidelines for Obtaining Quotes 

  

Please follow these simple guidelines when obtaining quotes. 

  

When contacting firms for Quotes be sure to:  

http://www.procurement.virginia.edu/pageguidelinesforcomp
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➢ Inform the firm you are seeking written quotes.  

➢ Explain exactly what you want to buy from the firm and when you want or 
need it by.  

➢ Provide a Date and Time the quote is due back to you. Be certain that the 
firm knows  

exactly when and where to send the quote and how you want it sent (i.e. via 
email, Fax, etc.).  

➢ Request firms include the following information in the quote:  

1. A Brief Description of each item desired.  

2. Part Numbers (if applicable)  

3. The Delivery Date  

4. Start and Completion Dates (if applicable)  

5. Any Delivery, Freight, Set-up Charges, etc.  

6. The Total Price for the desired Goods or Services  

  

When making phone calls to request a written quote, be certain to document the  

following in writing:  

1. The name(s) of firms contacted.  

2. The name(s), date(s), and time(s) of persons contacted at the firm.  

3. The firm’s ability and willingness to provide the desired Goods or Services.  

  

  

Terminology 

  

Throughout this training the terms "Supplier" and "Vendor" are used interchangeably. 

  

  

Upon completion of this section, you will be able to: 

• Shop with Hosted and PunchOut Catalog Suppliers 

• Compare products 

• Create a Non-Catalog Item Order 

• Request Buyer Assistance 

• Create a Quick Order 
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• Split a PTAEO  

• Enter notes to Approvers, Buyers, or Suppliers 

• Create an attachment 

• Insert an Approver and Change the Managerial Approver 

• Work with Notifications 

Shopping with Hosted Catalog Suppliers 

Procedure 

 
In this section you will learn how to shop with Hosted Catalog Suppliers.  

 

Hosted Catalogs are catalogs of products with UVA-negotiated prices that are hosted in the 

Marketplace.   

 

While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 

 
 

Step Action 

1. This is where you will enter the search terms for products from Hosted Catalogs. 

 

When you search for a product in this manner, you are searching among the hosted 

catalog vendors only.  You will not see products from non-catalog vendors or 

punchout vendors. 

 

Enter the desired information into the search field. In this example, 

enter "flexirack". 
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Step Action 

2. Click on the Go button. 

 

3. You will see all of the suppliers that carry the product that matches what you entered 

in the search field. 

 

To see additional information about the vendor, click on the vendor's name. You 

will see if the site is eVA registered, how the purchase order will be delivered to the 

vendor, and basic contact information. 

4. You can sort the products by clicking on the arrow for the Sort by drop-down list. 

 

Next, you will see how to add items to your cart. 

5. Find the item you want to add to your cart. 

 

Enter the desired information into the Quantity field. Enter "2". 

6. Click on the Add to Cart button. 

 

7. Find another item to add to your cart.  Note that you can select items from multiple 

vendors at once. 

 

Enter the desired information into the Quantity field. Enter "3". 

8. Click on the Add to Cart button. 

 

9. Scroll to the top to see your cart. 

 

Click on the Cart icon. 
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Step Action 

10. Click the Checkout button. 

 

11. The items are in your cart. 

 

If you need to remove an item from the cart, select the item by clicking the 

checkbox to the right of the price, and then clicking on the down arrow for the For 

selected line items field and choosing Remove Selected Items, then clicking on the 

Go button. 

 

If you need to change the quantity of an item, simply change the number in the 

quantity field, and click on the Save button. 

12. To see additional information about the vendor, you can click on the link for more 

info... or click on the vendor's name.  You can see how the purchase order will be 

delivered to the vendor and basic contact information. 

 

Next, you will submit your cart. 

 



 

Training Guide 
 

 

 Page 51 

 
 

Step Action 

13. Click on the Return Cart to Integrated System button. 

 

14. At this point, you can still change the quantity by clicking in the Quantity field, you 

can change the Deliver-To Location, or delete the line entirely by clicking on the 

trashcan icon. 

15. You can add any relevant information in the Reference Number field, although it is 

not required. Information added in the Reference Number field will show up on the 

printed purchase order. 

 

Important: When placing requisitions involving the fabrication of capital 

equipment, enter the fabrication asset number in the Reference Number field. 

16. You can view your preference defaults by clicking on the Update Line icon. 

 

Click on the Update Line icon. 
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Step Action 

17. Notice that PTAEO preferences default.  

 

You can override any of the PTAEO fields if needed.  You must make any necessary 

changes on each line separately.   

 

You may also add a Note to Buyer (which is an internal note) or a Note to Supplier 

(which will be sent to the vendor). 

 

If any changes are made, you must click both the Apply checkmark, and the Save 

button.   

18. Always ensure that the Expenditure Type field is accurate, since it should be 

changed depending on what is being purchased. 

 

Note that the Expenditure Type field is a required field. 

 

 
 

Step Action 

19. After checking all fields, including the Deliver-To Location field, click on the 

Submit button to submit the requisition. 
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Step Action 

20. A confirmation of the submitted requisition will be displayed.   

 

Notice the instructions on where to check on the requisition's status. 

 

Click on the Continue Shopping button. 

 

21. To check on the Requisition status, click on the Requistion number button. 

 

 

 

22. When the requisition becomes a purchase order you can see it in the Order number 

column.   

 

You will receive an email notification with the purchase order number. 

23. The Notifications link is where you can verify the PO Delivery Method (who 

delivers the order to the vendor).   

 

This is also where Approvers will review any requisitions they must approve. 

24. Congratulations!  You have completed the section on Shopping with Hosted 

Catalog Suppliers. 

End of Procedure. 

Comparing Products 

Procedure 

 
In this section you will learn how to compare two or more products. 

 

When you compare products, you are only comparing between two or more products from 

Hosted Catalog vendors.  Products from Punchout Catalogs are not included in the 

comparison. 

 

While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 
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Step Action 

1. Enter the desired information into the search field. Enter "latex free gloves". 

2. Click on the Go button. 

 

3. Scroll down to see the search results.   

 

Click compare to select the items you want to compare. 

 

4. To remove an item from the comparison, you can click on remove. 

 

Click on compare to select another item. 

 

5. You can see the items that have been selected to compare. 

 

Click on the Compare Selected: 2 button. 

 

6. To choose an item to add to your cart, change the quantity if desired, and click on 

the Add to Cart icon for the item.   

 

You can also select the item by clicking on the checkbox at the top, and clicking on 

the Go button next the Add to Cart action. 

 

If you don't want to select any of the items you chose to compare, you can click on 

the <<Back to Search Results button. 
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Step Action 

7. Congratulations!  You have completed the section on comparing products in 

the UVA Marketplace. 

End of Procedure. 

Shopping with Punchout Suppliers 

Shopping with Punchout Suppliers 

  

Punchout Suppliers are those vendors that have punchout catalogs in the UVA Marketplace. 
Punchout Catalogs are catalogs of products with UVA-negotiated prices where you will 

punchout to the vendor's web site to search for and select products.  

  

When you are selecting a Punchout Supplier, you will be opening the supplier's web site and 
following the directions on the supplier's site for ordering products.  These web sites are 

controlled by the vendor and vary in their appearance, navigation, and timeout (the amount of 
time you have in the catalog before you are timed out).  

  

Punchout web sites might be unavailable/down:  

• To add or remove products  

• To update or change pricing 

• For other reasons 

Sometimes the connection to the supplier cannot be established. This error reads as "Error 
UVA Marketplace: The connection to the supplier could not be established". This is not 
a result of IS connectivity. You should also contact Procurment Services (434.924.4212) to let 

them know there is an issue with a Punchout Supplier/Vendor.  

  

There are several different options available to resolve this issue. Select one of the following 

options that works best for your needs. They are:  

  

Option 1: If the order is needed immediately, and you know all the following information, 
then complete a Non-Catalog Item form to place the order to the vendor whose punchout site 

is not working.  

• Catalog Number 

• Product Description 

• Qty (Quantity) 

• UOM (Unit of Measure) 

• Unit Price  

Option 2: Select a different supplier/vendor (punchout or other) to complete the order.  

  

Option 3: Wait for the punchout supplier/vendor connectivity issue to be resolved.  
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Shopping with Punchout Suppliers 

Shopping with Punchout Suppliers 

Punchout Suppliers are those vendors that have punchout catalogs in the UVA Marketplace. Punchout 

Catalogs are catalogs of products with UVA-negotiated prices where you will punchout to the vendor's web 

site to search for and select products.  

When you are selecting a Punchout Supplier, you will be opening the supplier's web site and following the 

directions on the supplier's site for ordering products.  These web sites are controlled by the vendor and 

vary in their appearance, navigation, and timeout (the amount of time you have in the catalog before you 

are timed out). 

Punchout web sites might be unavailable/down:  

• To add or remove products  

• To update or change pricing 

• For other reasons 

Sometimes the connection to the supplier cannot be established. This error reads as "Error UVA 

Marketplace: The connection to the supplier could not be established". This is not a result of IS 

connectivity. You should also contact Procurment Services (434-924-4212) to let them know there is an 

issue with a Punchout Supplier/Vendor.  

There are several different options available to resolve this issue. Select one of the following options that 

works best for your needs. They are:  

Option 1: If the order is needed immediately, and you know all the following information, then complete a 

Non-Catalog Item form to place the order to the vendor whose punchout site is not working.  

• Catalog Number 

• Product Description 

• Qty (Quantity) 

• UOM (Unit of Measure) 

• Unit Price 

Option 2: Select a different supplier/vendor (punchout or other) to complete the order.  

Option 3: Wait for the punchout supplier/vendor connectivity issue to be resolved.  

Procedure 

 
In this section you will learn how to shop with Punchout Suppliers. 

 

While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 
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Step Action 

1. When you are selecting a Punchout Supplier, you will be opening the supplier's 

website and following the directions on the supplier's site for ordering products.   

 

Punchout websites are controlled by the vendor and vary in their appearance, 

navigation, and timeout (the amount of time you have in the catalog before you are 

timed out).   

 

Next you will see how to access a Punchout Supplier's online catalog. 

 

 
 

Step Action 

2. For this example you will simulate an order from a Punchout supplier. 

 

Click on America To Go. 

 

3. Most vendors will have several different methods to search for products.  Search for 

your product and add to your cart according to the vendor's directions. 
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Step Action 

4. When you have finished shopping on the vendor's website, click on their order 

button. 

 

Click on the Check Out button. 

 

5. To see additional information about the vendor, click on the more info... link or click 

on the vendor's name.  You can see how the purchase order will be delivered to the 

vendor and basic contact information. 

6. Click on the Return Cart to Integrated System button. 

 

7. Remember to ensure that you are using the correct PTAEO if you have set 

preferences. 

 

Click on the Update Line pencil icon to select another PTAEO set in preferences, 

split the PTAEO, or to override the fields that defaulted. 

 

Click on the Submit button. 

 

8. You will receive a confirmation when the requisition has been submitted. 

9. Congratulations!  You have completed the section on shopping with Punchout 

Suppliers in the UVA Marketplace. 

End of Procedure. 
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Creating Non-Catalog Item Orders 

Procedure 

 
In this section you will learn how to use the non-catalog item form to purchase from 

vendors who either 1) do not have a catalog in the UVA Marketplace, or 2) who have items 

you need to purchase that are not listed in their catalogs or are special-order items, or 3) to 

purchase items whose price is reduced especially for you, or 4) when a punch-out vendor's 

website is not available. 

 

To complete the non-catalog item form, you select the vendor, complete the on-line form 

with the information required to complete the purchase, and add products to your shopping 

cart.  You must complete all fields on the non-catalog item form. 

 

 
 

Step Action 

1. Click on the non-catalog form link. 

 

2. Click in the Enter Supplier field. 

 

3. You can type part of the name of the vendor in the Enter Supplier search field and 

the list of vendors with that word in their name will appear.   

 

For this example you are going to search for Beckman Coulter Inc as the Non-

Catalog Item vendor. 

 

Enter "Beckman". 
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Step Action 

4. All vendors with "Beckman" anywhere in the name will appear on the list.   

 

The list is sorted by best match, based on the way that UVA has flagged the 

vendors.  This means that contract vendors, and DMBE-certified (minority or 

woman-owned) vendors will appear first. 

 

If the list of vendors matching your search criteria is long, you will see "click here 

to view more supplier results", which will give you the complete list of vendors (it 

may be more than one page) with the vendor's site listed. 

5. Click on BECKMAN COULTER INC. 

 

6. You can also change the supplier by clicking on select different supplier. 

7. When you select the vendor from the list, you automatically select the site. 

 

If there are multiple sites, you can change the site by clicking on select different 

fulfillment center.  

8. For this example, you have selected the eVA registered site. 

9. Notice how the PO is delivered, so you know whether or not you have to fax or mail 

the PO to the vendor or if it will be sent automatically, and whether the site is an 

eVA registered site. 

 

For this example, the user must deliver the PO to the vendor. 

10. Enter detailed information about the product into the Product Description field.   

 

The Product Description field must include enough detail to satisfy eVA 

requirements for line item detail and permit the supplier to identify and fill 

your order.   

 

You are limited to 254 characters for this field, however. 

 

Click in the Product Name/Description field. 

 

11. Enter the desired information into the Product Name/Description field.  

 

Enter "Tubing kit". 

12. Press the [Tab] key on your keyboard to move through the fields. 



 

Training Guide 
 

 

 Page 61 

Step Action 

13. Enter the catalog number in the Catalog No. field. 

 

If there is not a catalog number, enter "None" or if you do not know the catalog 

number enter "Unknown". 

 

DO NOT enter item descriptions in this field. 

 

Enter "144689" into the Catalog No. field. 

14. Before completing the Quantity, Unit Price,and Unit of Measure, determine if you 

will be receiving one item for a specific price or multiple items/services at different 

varying dollar amounts.   

 

Examples of Right and Wrong Item Line Entry can be found at  

http://www.procurement.virginia.edu/pagecorrectcoding. 

15. Once decided, follow the appropriate guide below. 

 

Single Item: 

- Quantity equals the number of item(s). 

- Unit of Measure (UOM) is selected from the drop down list (usually Each). 

- Unit Price is the total dollar amount of the item(s). 

 

Multiple Items/Services: 

Usually are multiple invoices that are for different varying dollar amounts.   

- Quantity equals the total dollar amount.   

- UOM equals Dollar (U.S. Dollar) 

- Unit Price is a 1 (One). 

16. The ''Dollar'' Order Exception -When Should It Be Used? 

 

There are times when it is important to use a dollar order to make invoice matching 

in the Integrated System possible. 

 

Lumping multiple items together on one line with UOM "USD (dollar)": 

 

•Must be used when the unit price cannot be accurately determined in advance. This 

ensures that invoice(s) can be matched and that the PO can be reduced later if 

needed. These will most often be standing orders. 

 

•May be used on an order for an assortment of varied small dollar items that it 

would be impratical  and not useful to describe items individually and ascribe unit 

prices to. (Example:200 t-shirts in 20 different size and color combinations). 

17. Enter the desired information into the Quantity field.  

 

Note for Dollar Orders only, the Quantity will be the total dollar amount expected 

for the invoice, rounded up to the next dollar amount.  

 

This is not a dollar order, so enter a Quantity of "1". 
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Step Action 

18. The default Unit of Measure is "EA-Each".  However, you can change it as needed 

by clicking on the button to the right of the field.   

19. This is a sample of some other Unit of Measures you can select. 

 

Note if this is a Dollar Order, then select USD from the list of values. 

 

For this example, the default of EA-Each has been selected for you. 

20. Enter the desired information into the Unit Price field.  

 

Note for Dollar Orders only, the Unit Price will be a "1". 

 

This is not a dollar order so enter the unit price of "300.00". 

21. You can enter health, safety, and environmental information, if applicable, by 

checking these checkboxes. 

 

Items are still identified by expenditure type for health and safety requirements as 

well. 

22. If this is the only item you wish to purchase, you would click on the Save and Close 

button. 

 

In this example, you wish to purchase another item from the same vendor.   

 

Click on the Save and Add Another button to enter another item.   

 

 

23. The first ordered item is shown in the Recently added items list 

 

Enter the desired information into the Product Name/Description field for the next 

item. 

 

Enter "Ti 15 rotor".  

 

Note: Press the [TAB] key on your keyboard to move through the fields. 

24. Enter the catalog number is the Catalog No. field. 

 

If there is not a catalog number, enter "None" or "Unknown" if you do not know the 

catalog number. 

 

DO NOT enter item descriptions in this field. 

 

Enter "333857" into the Catalog No. field.  

 

25. Enter the desired information into the Quantity field.  

 

Enter a "1". 
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Step Action 

26. Enter the desired information into the Unit Price field.  

 

Enter "2500.00". 

27. The default Unit of Measure is "EA-Each".  However, you can change the Unit of 

Measure as needed.   

 

For this example, the default UOM (Unit Of Measure) has been selected for you. 

28. Click on the Save and Close button. 

 

29. The cart icon is located in the upper right hand corner.  Note the total dollar amount 

of the cart. 

 

Next, click the cart icon to proceed to checkout.  

30. Click the Checkout button to submit the cart. 

 

 

 
 

Step Action 

31. Review the cart details for correctness.   

 

Click on the Return Cart to Integrated System button. 
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Step Action 

32. Review the Requisition Information page for correctness; especially the Deliver-

To Location and the PTAEO information from the Update Line icon. 

 

Click on the Submit button. 

 

33. You will receive a confirmation when the requisition has been submitted. 

34. Congratulations!  You have completed the section on how to make purchases in 

the UVA Marketplace, using the non-catalog item form.  You should also have 

an understanding of the appropriate uses of the non-catalog item form.  

End of Procedure. 

Requesting Buyer Assistance 

Procedure 

 
You can request assistance with purchases from a Buyer in Procurement Services. 

 

Use the Buyer Assist form when the: 

-Vendor will not accept a purchase order 

-Vendor requires a signature on a contract 

-Vendor requires a prepayment 

 

Note: No purchase order will be created until the requisition has been reviewed by a Procurement 

and Supplier Diversity Services buyer. 
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While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 

 
 

Step Action 

1. Click on the Buyer Assist tab. 

 

2. The Item Type selected will depend on whether you are buying Goods or buying 

Services.  

 

Note: Select either Goods billed by quantity or Services billed by quantity if you 

do not wish to encumber funds. 

3. Enter as much information as possible about the item(s) in the Item Description 

field. 

 

You may also enter any suggested suppliers.  The supplier's name should be entered 

as it appears in the Vendor file.   

 

Also include the Deliver-To Location information (where you want the goods to be 

sent) in the Item Description field. 

 

In this example, the Item Description has been entered for you. 
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Step Action 

4. The Category you select helps determine which Buyer is assigned to review the 

requisition. 

 

You may use the flashlight icon to search for a specific category.  The "%" sign is 

the search wildcard. 

 

In this example, the Category has been entered for you. 

5. Before completing the next three fields, determine if you will be receiving one item 

for a specific price or multiple items/services at different varying dollar amounts.  

Once decided, follow the appropriate guide below. 

 

Single Item: 

- Quantity equals the number of item(s). 

- Unit of Measure (UOM) is selected from the drop down list (usually Each). 

- Rate per Unit is the total dollar amount of the item(s). 

 

Multiple Items/Services: 

Usually are multiple invoices that are for different varying dollar amounts.   

- Quantity equals the total dollar amount.   

- UOM equals Dollar (U.S. Dollar) 

- Rate per Unit is a 1 (One). 

6. For this example the Quantity, Unit of Measure, and Rate per Unit have been 

entered for you. 

7. Click on the Add to Cart button. 

 

8. Notice that the line has been added to your cart.  You can request help with another 

line item by clicking on Clear All (which clears the fields, but does not delete the 

line), entering the information for the next line and clicking on the Add to Cart 

button. 

9. Click on the View Cart and Checkout button. 

 

 



 

Training Guide 
 

 

 Page 67 

 
 

Step Action 

10. Note:  No purchase order number will be generated until Procurement has reviewed 

the requisition. 

 

Click on the Submit button. 

 

11. Congratulations!  You have completed the section on Requesting Buyer 

Assistance. 

End of Procedure. 

Creating a Quick Order 

Procedure 

 
Use Quick Order when you know a particular catalog or sku number, and do not need to 

view or compare products. 

 

While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 
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Step Action 

1. Click on the quick order link. 
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Step Action 

2. You will enter the catalog or SKU number.  It is possible that a manufacturer or part 

number will also result in a match. 

  

Enter the desired information into the Part Number (SKU) field.   

 

Enter "plt556". 

 

 
 

Step Action 

3. Click on the Add to Active Cart button. 

 

4. If your search returns no results, then verify the Part Number (SKU) was entered 

correctly. This could mean that item may no longer be available. 

 

Re-query for a different item, as needed.  

5. This example is a requery with part number 1120. 

 

When you add items to your cart with Quick Order, you will see a confirmation of 

what you have added. 

 

If your search returns more than one item you will see the items and vendors so that 

you can select one. 
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Step Action 

6. Click on the Add to Cart button. 
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Step Action 

7. View the cart by clicking on the link. 

 

 

 
 

Step Action 

8. Click the View My Cart link. 

 

9. If you need to remove an item from the cart, select the item by clicking the 

checkbox to the right of the extended price, and then clicking on the down arrow for 

the For selected line items field and choosing Remove Selected Items, then 

clicking on the Go button. 

 

If you need to change the quantity of an item, simply change the number in the 

Quantity field. 
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Step Action 

10. Change the quantity here if you need to.   

 

In the Quantity field, change the quantity if appropriate. Enter "3". 

11. Click on the Save/Update button. 

 

12. Click on the Return Cart to Integrated System button. 
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Step Action 

13. Click on the Submit button. 

 

14. Congratulations!  You have completed the section on purchasing products 

using the Quick Order feature in the UVA Marketplace. 

End of Procedure. 

Splitting a PTAEO for Purchases 

Procedure 

 
You may split a purchase among several PTAEOs, or you may need to change the expenditure 

type for only one of the lines of a purchase.  The following instructions will show you how. 

 

While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 
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Step Action 

1. In order to view / update the PTAEO information, click on the Update Lines icon. 
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Step Action 

2. Click on the Add Another Row icon. 

 

3. You can click on the arrow for the Nickname field to view and select a preset 

PTAEO preference. 

 

If you only have one PTAEO preference entered, it will default, like shown here. 

4. Enter the desired information into the Project field. Enter "100000". 

 

Overriding the information in the Project field, will automatically erase the 

information in the Task and Award fields. 

5. Enter the desired information into the Task field. Enter "101". 

6. Click in the Award field. 

 

Enter the Award. In this training session the award will be entered automatically. 

 

7. Click in the Expenditure Type field. 

Enter the Expenditure Type.   

 

In this training session the Expenditure Type will be entered for you automatically. 

 

8. When you scroll over to see the Percent, Quantity and Amount fields, the first line 

will default with 100 Percent, and the total Quantity of items ordered, and the total 

Amount. 

 

You can change the Percent, Quantity or Amount Fields; you do not have to 

change all three.  If you change one, the others will change automatically based on 

the value you input. 
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Step Action 

9. For this example, you will split the expense equally between the two different 

PTAEO's. 

 

Enter "50" in the Percent field for line one and TAB. 
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Step Action 

10. Enter the desired information into the Percent field. Enter "50" and TAB. 

 

Note: The total percent must equal 100. 

11. After entering the information in the Percent, Quantity, or Amount field, the other 

two fields will automatically default when you navigate out of the field, whether by 

clicking out or pressing [Tab]. 

12. If you want to apply the split to all lines of the requisition, check the checkbox to the 

left of "Apply this Cost Allocation information to all applicable requisition 

lines". 

13. Click on the Apply button. 

 

14. Click on the Submit button. 

 

15. Congratulations!  You have completed the section on splitting a PTAEO for 

purchases made in the UVA Marketplace. 

End of Procedure. 

Adding Notes to Approvers, Buyers, Suppliers, or Receivers 

Procedure 

 
In this section you will learn how to add notes to the approvers, the buyers, the suppliers, 

and/or the receivers. 

 

While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 

 

 

Step Action 

1. The note to the Approver is done on the Justification line, located directly under the 

Description. 

 

You enter your notes to the buyer, the supplier, and/or receiver in iProcurement, 

from the Requisition Information page via the Update Line icon. 

 



Training Guide 

 
 

 

 Page 78 

 
 

Step Action 

2. Click on the Update Line icon. 

 

3. You add notes in these fields. 

 

The Note to Buyer and the Note to Receiver fields are internal messages and will not 

be put on the purchase order. 

 

It is important to know that your note to the supplier will show up for all purchase 

orders created from this requisition.  If you order from multiple vendors on a 

single requisition, and add a note to the supplier, then all of the vendors will get 

the note. 
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Step Action 

4. When done adding your notes, click on the Apply button. 

 

5. Click on the Submit button. 

 

6. Congratulations!  You have completed the section on Adding Notes to 

Approvers, Buyers, Suppliers and/or Receivers. 

End of Procedure. 

Adding an Attachment to a Requisition 

Procedure 

 
In this section you will learn how to add attachments to requisitions.   You can attach 

documents, pictures, web sites (URLs), or text attachments. 

 

While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 
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Step Action 

1. You add attachments in iProcurement, from the bottom of the Requisition 

Information page. 

 

Attachments are internal to UVA and will not be forwarded to the supplier. 

 

Scroll down to the bottom of the page. 

 

 
 

Step Action 

2. Click on the Add Attachment... button. 
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Step Action 

3. You must specifiy the type of attachment.  The default will be Short Text, however 

for this example you will attach a file. 

 

Click on the Dropdown Arrow. 

 

4. Click on File 

 

5. The Description field is a required field. For this training the description will be 

entered for you. 

6. Miscellaneous is the default for the Category field. 

 

Do not change it! 

7. You will attach a Sole Source Justification form that was completed and saved on a 

C: drive of the computer. 

 

Click on the Browse... button. 

 

8. Browsing will allow you to find the file you want to attach and select it. 

9. By clicking on the Add Another button, you can add multiple attachments (short 

text and file.)  Always verify that the attachment is the correct one. 
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Step Action 

10. Click on the Apply button. 

 

 

 
 

Step Action 

11. Notice the confirmation statement. 

 

Click on the Close button. 

 

12. Click the Submit button. 
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Step Action 

13. Click on the Continue Shopping button on the Confirmation screen. 

 

14. Click on the Requisitions/Orders tab to view the attachment. 

 

15. Click on the Requisition 1191389 link. 

 

16. Notice that Attachment has an item you may view. 

17. Congratulations!  You have completed the section on adding attachments to 

requisitions. 

End of Procedure. 

Inserting an Approver 

Procedure 

 
Inserting an approver allows you to insert an additional approver into your hierarchy 

(workflow). The user decides where in the hierarchy the newly inserted approver will fall; before 

or after the original approver.This only affects the current requisition.  

 

In this section you will learn how to insert an approver. 
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While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 

 
 

Step Action 

1. You can insert an approver in iProcurement after you have submitted your order in 

the UVA Marketplace. 

 

Click on the Manage Approvals button. 

 

2. The Insert Approver action button defaults selected.   

3. Select the new approver. 

 

You can click on the search icon, or type in the person's name (last name first) and 

press the [Tab] key. 

4. For this example, the approver has been entered for you. 

 

The Add to Location defaults to First Approver.   
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Step Action 

5. Click on the Submit button. 

 

6. The approver has been added.  
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Step Action 

7. If you desire you may print this page using the Printable Page button. 

 

Click on the Submit button. 

 

8. Congratulations! You have completed the section on Inserting an Approver. 

End of Procedure. 

Changing Managerial Approver 

Procedure 

 
Changing managerial approver allows you to change your approval hierarchy (workflow) 

by removing the current approver.  Use this option whenever your current approver is not 

available (out of the office). This only affects the current requisition.    

 

While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 

 
 

Step Action 

1. You can insert an approver in iProcurement after you have submitted your order in 

the UVA Marketplace. 

 

Click on the Manage Approvals button. 
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Step Action 

2. The Insert Approver action defaults selected.  

3. Click on the Change Managerial Approver radio button. 

 

4. Select the new managerial approver.   

 

You can click on the search icon, or type in the person's name (last name first) and 

press the [Tab] key. 

 

Click in the New Managerial Approver field.   

 

 

 
 

Step Action 

5. For this example, a new managerial approver was entered for you. 

 

Click on the Submit button. 

 

6. The requisition will now route to the new managerial approver. 

7. Click on the Submit button. 
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Step Action 

8. Congratulations!  You have completed the section on Changing Managerial 

Approver. 

End of Procedure. 

Working with Purchase Requisition Notifications 

Procedure 

 
Your Notifications (requisitions that require your approval, etc.) will appear in your 

Worklist.   

 

You may also approve via email, or from the Notifications link on the Requisitions/Orders 

tab within iProcurement. 

 

In this section you will learn how to view your notifications in the worklist, and edit and 

approve a requisition that has been sent to you for approval. 

 

While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 

 
 

Step Action 

1. Click on the requisition link. 
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Step Action 

2. You can do any of the approval actions you see at the top right, but you may also 

view the requisition details and/or edit the requisition. 

 

 
 

Step Action 

3. Click on the Vertical Scrollbar to scroll to the bottom of the page to view the 

Requisition Details. 

 



Training Guide 

 
 

 

 Page 90 

 
 

Step Action 

4. Click on the View Requisition Details button. 

 

5. Click on the blue Details icon. 
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Step Action 

6. Click on the Show Additional Information link to review the PTAEO information. 

 

7. Review the PTAEO and requisition details information.   

 

Click on the Hide Additional Information link. 

 

8. Click on the Return button. 

 

9. Click on the Return button. 
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Step Action 

10. Click on the Edit Requisition link. 
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Step Action 

11. You can make changes as appropriate. 

   

Click on the Approver Checkout button. 

 

12. You can change the billing information here if appropriate. 

 

 
 

Step Action 

13. Click on the Next button. 
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Step Action 

14. Click on the Next button. 

 

15. Click on the Submit button. 

 

16. Click on the Continue button. 

 

17. Click on the Approve button. 

 

18. The notification has been removed from the worklist. 

19. Congratulations!  You have completed the section on Working with 

Notifications. 

End of Procedure. 

Setting up Vacation Rules 

Procedure 

 
Users who approve purchase requisitions can establish vacation rules so that requisition approval 

requests are automatically routed to an alternate approver during planned absences. 

 

In this simulation you will set up a vacation rule for purchase requisition approval. 
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Step Action 

1. Click the Full List button. 
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Step Action 

2. Click the Vacation Rules link. 

 

 

 
 

Step Action 

3. Click the Create Rule button. 
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Step Action 

4. Click the Item Type list. 

 

5. Click the PO Requisition Approval list item. 

 

6. Click the Next button. 
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Step Action 

7. Click the Select radio button. 

 

8. Click the Look Up icon. 
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Step Action 

9. Click the Go button. 

 

10. Click the Quick Select icon. 

 

 

 
 

Step Action 

11. Click the Next button. 

 

12. You must enter a Start Date that represents when you wish for the alternate 

approver to begin receiving requisition approval requests on your behalf. 

 

The End Date represents the date and time you wish to STOP forwarding 

requisition approval requests to your alternate approver. 

 

Tip: Use the calendar to select the dates. 

 

For this example, the information has been entered for you. 
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Step Action 

13. Click the Respond radio button. 

 

14. Enter the desired information into the Note field.  

 

Enter "Sue Clements approving requisitions in my absence.". 

15. There are several ways to search for the name of the alternate approver.  

 

1) Enter the last name in the blank field and tab 

or 

2) Use the search (Look Up) icon at the end of the blank field 
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Step Action 

16. Click the Look Up icon to find a list of alternate approvers. 
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Step Action 

17. When the Search page opens, enter the last name of the person who will approve 

requisitions in your absence, then click the Go button.  

 

Locate the name in the list, then click the Quick Select icon next to their name. 

 

 

 
 

Step Action 

18. Click the Approver Action drop down list. 

 

19. Click the Forward list item. 

 

20. Click the Apply button. 

 

21. The vacation rule is now ready. 

22. Congratulations, you have completed the simulation to set up a vacation rule for 

purchase requisition approval. 

End of Procedure. 

Troubleshooting Approvals 

Troubleshooting Approvals    
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The information found on this page will assist you when something goes wrong during the 

requisition approval process. The system may send you an alert to warn you that there is a 

potential problem.  

  

Inserting an Approver   

  

Error. You do not have the authority to submit this requisition.   You cannot 

submit your requisition. Your purchasing status has changed because either you are no longer 

self-approving or you no longer see your approver listed. Sometimes you become disconnected 

from the hierarchy (workflow) if you or your approver has had an HR position number change.  

  

Solution: You should:  

a. Insert an approver for the requisition using the instructions called "Inserting an 

Approver" (found under Shopping in the UVa Marketplace).  

  

b. Send email to isaccess@virginia.edu (mailto:isaccess@virginia.edu) to request that the 
hierarchy (workflow) issue be resolved. 

  

  

How do you add multiple approvers for a requisition?   

  

Solution: When a requisition requires multiple approvers, following instructions for 

Inserting an Approver.  

  

  

Change Managerial Approver   

  

"FYI: No approver found for Requisition Number #######".  You receive an email 
notification when this happens. You have submitted a requisition and it is not approved within 
a 72 hour period. The requisition has timed out. Your approver did not take action in a timely 

manner. The requisition is sent back to you (the originator) as an Incomplete (status) 

requisition.   

  

Solutions: You have a few options.  

Option 1. Resubmit the requisition to your approver if they are in the office 

  

   To resubmit the requisition to the same approver:  

mailto:isaccess@virginia.edu
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• Navigate to the Requisition/Order tab in iProcurement 

• Locate the requisition number and click on it 

• Click Complete 

• Click Yes 

• Click Checkout 

• Click Submit  

Option 2. If the approver is out of the office, then you can change the managerial approver to 

someone else if you know the name of another approver.  

  

    If you can identify a new approver, then follow the instructions to "Change Managerial 

Approver".  

  

If you cannot identify a new approver, then run the UBI report called “Oracle 
Responsibilities”. This report will help you see a listing of all those in your org who have a 
purchasing responsibility so that you can choose an alternate approver. Once the report runs, 
select your Org. number and the Responsibility name.  The page will display all those with the 
selected responsibility from within the selected org. 

  

  

  

How do you remove an approver that was mistakenly added to a requisition?  

An approver that was mistakenly added to the workflow can be removed. If a requisition is not 

fully approved, then find the requisition, withdraw it, correct the approver, and then resubmit 

it.  

  

1.Navigate to the Requisition/Order tab in iProcurement. 
2.Locate the requisition number and click on the requisition number link. 

3.Click on the Change button. 
4.Click Yes. 

5.Click Checkout.  

6.Click the Next button. 

7.Click Manage Approvals. The Insert Approver action defaults selected. 

8.Click the Change Managerial Approver radio button. 

9.Click in the New Managerial Approver field. Select the new managerial approver. You can click on the 

search icon, or type in the person's name (last name first) and press the Tab key. 

10.Click Submit. The requisition will now route to the new managerial approver. 

11.Click Submit again. 

  

  

ESHARP  
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How do I make a permanent change to a new approver? 

  

If your approver has left the department, and you need to have your requisitions route to a 
new approver, then complete an ESHARP request. Within ESHARP (under Purchasing) select 

the UVA PO Change Approver.  

  

Link to ESHARP (http://its.virginia.edu/esharp)  

  

  

Working with Favorites in the UVA Marketplace 

An easy way to order frequently purchased items is to create and use a Favorites folder. You can 
create a Favorites folder/subfolder, add Hosted Catalog or Non-Catalog items to the Favorites 
folder, and create orders using your Favorites folders. However, for Punchout vendors, you can 
only create a Favorites folder on their website (if they offer that functionality). 

  

Upon completion of this section, you will be able to:  

• Create a Favorites folder 

• Add items to the folder 

• Create a requisition using favorites 

Creating and Managing Favorites 

Procedure 

 
Organize frequently purchased items into Favorite folders in the UVA Marketplace.  You 

can create folders and subfolders. 

 

In this section you will learn how to create and manage Favorite folders in the UVA 

Marketplace. 

 

While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 

http://its.virginia.edu/esharp
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Step Action 

1. Click on the favorites link. 
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Step Action 

2. Click on the Add New button to create a new Favorite folder. 

 

3. You may either create a new top level personal folder or a subfolder of the selected 

folder. 

 

Click on Top level personal folder. 

 

 

4. The Create Personal Folder page displays. 

 

Enter "Lab supplies" in the Name field. 

5. Enter "Supplies" in the Internal Name field. 

6. Enter "Lab supplies" in the Description field. 

7. Click on the Save Changes button. 

 

8. The newly created folder is listed under the Personal favorites. 

 

You may edit or delete the folder appropriately as needed. 

9. If you want to share a list of favorite items with others, contact the SciQuest 

coordinator in the Procurement and Supplier Diversity Services department (434-

924-4212) for their assistance. 

10. Congratulations!  You have completed the section on Creating and Managing 

Favorites in the UVA Marketplace. 

End of Procedure. 

Adding Items to Favorites 

Procedure 

 
In this section you will learn how to add items from hosted catalogs and from the non-

catalog item form to a Favorites folder. 

 

While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 
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Step Action 

1. Adding an item from a hosted catalog:  

 

Search for the item to add to your Favorite's folder.  

 

If you want a particular quantity added to the Favorite you can change it now, but 

you will also have the opportunity to change the quantity when you place orders 

using favorites. 

 

Click the add favorite link. 

 

2. Click on Lab supplies folder found in the list of Personal Favorites. 
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Step Action 

3. Click on the Save Changes button. 

 

4. The items will be listed in your favorites folder. You can use the folder to select 

items and add them to a cart. You may update the quantity as needed.  

5. Adding items from a non-catalog item form: 

 

Add the items to your cart from the non-catalog item form and click on the cart. 
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Step Action 

6. Click on the checkbox for all items, or select individual items, you want to add to 

the Favorites folder. 

 

Click on the checkbox for all items. 

 

7. Click the Go button. 

 

8. Click on Lab supplies folder found in the list of Personal favorites. 

 

9. Click the Save Changes button. 

 

10. You will see a quick Success confirmation that the product has been successfully 

added to the Cart. 
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Step Action 

11. Click the shop icon. 

 

12. Click the View Favorites link. 

 

13. You will see the items you added in the folder.  You can use the folder to select 

items and add them to the cart. 

14. If you want to share a list of favorite items with others, contact the SciQuest 

coordinator in the Procurement and Supplier Diversity Services department (434-

924-4212) for their assistance. 

15. Congratulations!  You have completed the section on Adding Items to 

Favorites. 

End of Procedure. 

Using Favorites to Create Orders 

Procedure 

 
You can use your list of favorites to easily create orders.  In this section you will learn how 

to create orders using your Favorites folders. 
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Step Action 

1. Click the View Favorites link. 
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Step Action 

2. Locate the folder where the items you wish to purchase are listed. 

 

Click on Lab supplies folder. 

 

3. You can select all items in the list at once by selecting the checkbox for the folder. 

4. You can add to cart, edit, move, copy, or delete all the items after selecting the 

checkbox for the folder. 

 

 
 

Step Action 

5. Click on the checkbox for the item(s) you want to order. 
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Step Action 

6. You may change the quantity as needed. 

 

Click the Add to Cart button. 
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Step Action 

7. You will see a quick Success confirmation that the product has been successfully 

added to the cart. 

 

Click the Cart link. 

 

 

 
 

Step Action 

8. Click the View My Cart button. 
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Step Action 

9. The items are in your cart.  Continue to create your order by clicking the Return 

Cart to Integrated System button. 
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Step Action 

10. Congratulations!  You have completed the section on Using Favorites to Create 

Orders. 

End of Procedure. 

Working with Requisitions in iProcurement 

Upon completion of this section, you will be able to do the following in iProcurement: 

• Save requisitions 

• View requisitions 

• View purchase orders 

• Print requisitions 

• Change requisitions - You can change the following items:  
o Need-By Date 
o Quantity 
o Price (only if USD is the UOM) 
o Add Attachments 
o Manage Approvals (Insert an Approver or Change Mangerial Approver) 

• Cancel requisitions - You can cancel either individual lines or the entire requisition. 

Saving a Requisition 

Procedure 

 
You may start a requisition (items are in a cart) but find that you need to stop before submitting it. 

You can save the requisition and complete it later.  

 

Ex: You start a requisition but have to leave before you can finish it, or you are working on a 

requisition but need to stop and create a new requisition to a different supplier/vendor.   

 

In this section you will create and save a requisition.  

 

 

Step Action 

1. The best business practice is to always begin shopping with an empty cart.  

Sometimes, that does not happen and there will already be items in your cart.   

 

For this example, some items will be put into your cart for you. . 
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Step Action 

2. Click the Save/Update button. 

 

3. Click the Return Cart to Integrated System button. 

 

4. Click the Save button. 
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Step Action 

5. Click the New Cart button. 

 

6. Your Shopping Cart is now empty. You can either complete requisition 1191393 or 

begin searching for the next item(s) you need to purchase.  

 

Note: Requisition number 1191393 for $76.85 is saved with an Incomplete status. It 

is waiting to be completed. 

7. Congratulations! You have completed the section on how to create and save a 

requisition. 

End of Procedure. 

Viewing Requisitions and Purchase Orders 

Procedure 

 
In this section you will learn how to view your Requisitions and Purchase Orders. 

 

You may also view Purchase Orders in the UVA Marketplace.  If you need to view a 

purchase order with the intent to print it, then you should view it in the UVA Marketplace.  

(See the instructions for Printing.) 

 

While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 
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Step Action 

1. You will see your list of requisitions here, but to see more detail, including the 

purchase order numbers, date requisition was created, etc. you must click on the 

Requisitions/Orders tab. 

 

You can also click on the Full List button to see this additional information. 

 

Click on the Requisitions/Orders tab. 

 

2. The Requisitions/Orders tab displays. You can view the requisition information 

such as Requisition number, Requisition Supplier, Description, Total amount, 

Creation Date, and the Requisition Status.  

 

Requisition Status definitions: 

• Incomplete requisition is a saved cart. 

• Pre-Approved requisition is approved, but forwarded to another approver. 

• Rejected has been rejected by your approver or a Procurement Services Buyer. 

• Returned is where the approver or buyer has returned the requisition without 

creating a purchase order. 

• In-Process requisition has been submitted but not yet approved. 

• Approved means the requisition is ready to become a purchase order.  

• Canceled requisition has been canceled. 

• Requires Reapproval means that you or an approver made a change that requires 

reapproval.  
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Step Action 

3. Use the Search button to find requisitions that were created by someone else.  

 

Tip: When the search window opens, click the Clear button and search by the 

individual's last name (using the Flashlight icon). 

4. To view the purchase order, you can click on the purchase order number link. 

 

If there is no order number, then the requisition has not become a purchase order 

yet. 

 

 
 

Step Action 

5. Click on the Requisition Number link. 

 

6. Click on the blue Details icon. 

 

7. The Requisition Details page displays.  View the Order information (Shipments, 

Receipts, or Invoices).  

 

Click on the Show Additional Information link to see the PTAEO information. 
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Step Action 

8. If the requisition does not have an assigned purchase order number yet, then it may 

be waiting for approval by Procurement.  

 

Verify that it has been assigned to a Procurement Buyer here. 

9. Click on the vertical scrollbar to see additional information at the bottom of the 

page. 

 

 
 

Step Action 

10. Make sure to review the PTAEO information to insure accuracy. 

 

Click on the Hide Additional Information link. 
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Step Action 

11. Click on the Requisition Details link to return to the requisition. 

 

12. Congratulations!  You have completed the section on Viewing Requisitions and 

Purchase Orders in iProcurement. 

End of Procedure. 

Printing Requisitions 

Procedure 

 
This section will show you how to print your requisition from iProcurement.  If a purchase 

order has been created, you can also go into the UVA Marketplace, find the purchase order 

and view and/or print the original requisition. 

 

If you need to print a requisition before a purchase order is created, follow these 

instructions. 

 

While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 
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Step Action 

1. The easiest way to print a requisition is upon Returing to the Integrated System. 

 

Click on the Printable Page button. 

 

Another window will open, from which you can print by clicking on your browser's 

printer icon. 

 

2. You can also print the requisition by selecting File>Print. 

3. The next steps will show you how to print a requisition after it has been submitted. 
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Step Action 

4. Find the requisition you want to print. 

 

Click on the requisition 1191390. 

 

5. Click on the blue Details button. 

 

6. Click on the Show Additional Information link. 
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Step Action 

7. Click on the File menu. 

 

8. Select Print... from the menu. 
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Step Action 

9. Click on the Preferences button. 

 

10. Ensure that the Orientation is set to Landscape. 

 

 
 

Step Action 

11. Click on the OK button. 
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Step Action 

12. Click on the Print button. 

 

13. Congratulations!  You have completed the section on Printing Requisitions. 

End of Procedure. 

Changing Requisitions 

Procedure 

 
For Hosted Catalog and Non-Catalog orders, you may change any information, except for 

the item description and price. 

 

For Punchout Orders you can only change the billing information.   

 

While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 
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Step Action 

1. Find the requisition that you want to change.   

 

Ensure that the requisition has not been received or invoiced against. (To view this 

information, click on the Requisition number and the blue Details icon).   

 

Click on the requisition Change button. 
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Step Action 

2. For this example, you will enter a new amount in the Quantity field.   

 

Click in the Quantity field.  
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Step Action 

3. For this example, we have removed the incorrect quantity.  

 

Enter the desired information into the Quantity field. Enter "3". 

 

 
 

Step Action 

4. Click in the Reason field. 
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Step Action 

5. Enter a reason for changing the quantity.   

 

Enter the desired information into the Reason field. Enter "Needed 2 more". 
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Step Action 

6. Click on the Next button. 

 

 

 
 

Step Action 

7. Click on the Next button. 
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Step Action 

8. Click on the Submit button. 

 

9. You will receive a confirmation that your changes have been submitted. 
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Step Action 

10. From the Requisitions/Orders tab, click the Notifications link to view any system 

generated messages regarding the change. 

 

11. Click the Subject link for Response to Requisition (#) Change Request. 

12. The page displays. 

 

No action is required for this item. 

 

Use the OK button to exit this screen. 

 

 
 

Step Action 

13. Click the Subject link for the Standard Purchase Order XXXXXXX has been 

approved item. 

 

14. Review the notification, especially the Order Delivery Method.  

 

Note: Whenever a requisition is modified that has an assigned Purchase Order 

number, then the User (you) must deliver the PO to the vendor. 

 

Click the OK button. 
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Step Action 

15. There are no other notifications to review for this transaction. 

 

Click the Shop tab to exit and continue shopping. 

 

16. Congratulations!  You have completed the section on Changing Requisitions. 

End of Procedure. 

Canceling Requisitions 

Procedure 

 
You can cancel either individual requisition lines or the entire requisition.  

 

Note: If you cancel a requisition that has an assigned purchase order number, then you 

must communicate the cancellation change to the vendor. 

 

In this section you will learn how to cancel a requisition.    

 

While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 
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Step Action 

1. Find the requisition you want to cancel.  

 

Click on the requisition 1191390 number. 

 

2. Click on the Cancel Requisition button. 

 

3. If your requisition has more than one line, you can cancel individual lines without 

canceling the entire requisition by clicking on the Select checkbox and the Continue 

button.  For this example, you will cancel the entire requisition. 

 

Click on the Cancel Entire Requisition button. 

 

4. Click on the Submit button. 

 

5. Notice the confirmation message at the top of the page.  To see that the requisition 

was cancelled, return to the Requisitions/Orders tab. 

 

Click on the Requisitions/Orders tab. 

 

6. You will see Cancelled as the Requisition Status.  To see the lines or details of the 

cancelled requisition, you can click on the requisition number. 
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Step Action 

7. From the Details page of the requisition, you will see the line(s) identified that has 

been canceled. 

8. Congratulations!  You have completed the section on canceling requisitions. 

End of Procedure. 

Correcting the Accounting Date (Invalid GL Date) in iProcurement 
(Requisition) 

When you create and save a requisition in one month and do not approve it during that month, 
or the requisition is returned to you and you approve it in a different month, you will need to 
change the GL (General Ledger) Date. The GL Date is used to determine the correct 
accounting period for your transaction.  
  
This date is automatically entered when you save the requisition. Because the periods are 
closed on the last day of the month, you will need to reflect an "open" or "current" period date 
in the GL Date field.  
  
  
Unable to Reserve Standard Purchase Order XXXXXXX Notification  
  
You may receive an Unable to Reserve Standard Purchase Order XXXXXXX notification. 
The notification reads like this: Line #1 Shipment #1 Distribution #1 The accounting date 
is not in an open encumbrance period. You will follow the instructions in this topic to fix the 
GL Date. 
  
  
  
  
  

Procedure 

 
You may receive an Unable to Reserve Standard Purchase Order XXXXXXX notification. 

The notification reads like this: Line #1 Shipment #1 Distribution #1 The accounting date is 

not in an open encumbrance period. 

 

Next you will see how to correct an invalid GL Date. 
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Step Action 

1. Click the Submit button. 

 

2. Note the red Error message. You must change the GL Date before you can submit 

the requisition. 

 

Notes: 

You may need to change the GL Date for multiple lines.  

 

You will not be able to leave this page until you change the GL Date to the first 

day of the next month for each line, as needed. 

3. Access the calendar to change the GL Date. 
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Step Action 

4. Click the first day of the next month date. 
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Step Action 

5. Click the Apply button. 

 

6. Click the Submit button. 

 

7. You will receive a confirmation that the requisition has been submitted. 

 

Note: If you are self-approving (or if your approver approves the requisition on the 

same day), then the PO will be generated, but it will remain in an Incomplete status. 

To move the PO forward (out the door), you will have to update the GL date on the 

resulting PO and approve it (both in PO Summary). 

8. Congratulations! You have completed this section on how to correct the accounting 

date (an invalid GL Date) in iProcurement for a requisition. 

End of Procedure. 

Troubleshooting Requisitions 

Troubleshooting Requisitions 

  

Sometimes a requisition does not automatically receive a system generated purchase order (PO) number. 

This happens when the person who created the requisition does not have approval authority. Therefore, the 

requisition will route to someone else within the department for approval. However, there are also other 

reasons why a purchase order number is not generated. Sometimes requisitions must route to Procurement 

or other central offices for their review and approval.  

  

  

Capital and Non-Capital Equipment Requisitions 

  

Requisitions submitted with a capital equipment expenditure type automatically route to the departmental 

approver first, and then go to Asset Accounting for their approval. Click here 

(http://www.virginia.edu/finance/finanalysis/eqp_expnd_typ.html) for a list of Capital or Non-Capital 

equipment expenditure types and their descriptions. 

  

An item is considered Capital Equipment when it meets ALL FOUR of the following criteria: 

1. Cost of an equipment item must exceed $5,000 

2. Useful life of equipment must exceed one year 

3. UVA must retain title or ownership of equipment 

4. Equipment must be functional as a standalone or as an integral component of larger UVA owned system 

  

http://www.virginia.edu/finance/finanalysis/eqp_expnd_typ.html
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Procurement Services Approval   

  

Note:  If a requisition routes to Procurement for approval, then the Procurement Services Buyer will create 

the PO. Users must monitor the Requisitions/Order tab to determine if a PO has been created/approved and 

the PO number. The system will not send an email notification to the user. 

  

The reasons a requisition will route to the central Procurement office are outlined below.  

  

1.  The total of the requisition is $5,000 or greater and the vendor is a Non-Contract vendor. 

  

2. The total of the requisition is $50,000 or greater and the vendor is a Contract vendor. 

  

3. The requisition is for a restricted expenditure type. Requisitions with any of the following expenditure 

types will always route to Procurement Services. 

• Supplies, Lab, Radioactive 

• Supplies, Pharmaceutical Drugs 

• Svcs, Emp Moving, Trans & Stor 

• Svcs, Moving & Relocation, Emp 

• Travel Costs, Training (all) 

• Travel, Agent Fees 

• Travel, Aid 

• Travel, Meals Actual, For 

• Travel Meals Actual, US 

• Travel, Meals Per Diem, For 

• Trave, Meals Per Diem, US 

• Travel, OSP Trainee 

• Travel, Other Airline Fees, For 

• Travel, Other Airline Fees, US 

• Travel, Public Carrier, For 

• Travel, Public Carrier, US 

• Travel, Rental Vehicles, For 

• Travel, Rental Vehicles, US 

• Travel, State Vehicles 

• Travel, Subsist & Lodging, For 

• Travel, Subsist & Lodging, US 

• Eq NonCapital Law Enforcement 

• Eq Capital Law Enforcement 

• Supplies, Law Enforcement 

• Eq Capital Motor Vehicles 

• Eq NonCapital Motor Vehicles 

• Meals, Athletic Stdnt Use Only 
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4. The Buyer Assist form was used to create the requisition. This form automatically routes to Procurement 

Services no matter what content or accounting information was provided. 

  

5. There is a problem with the supplier or supplier site set up for the vendor used on the requisition. If you 

did not use the Buyer Assist form, but the supplier field is blank on the requisition, a problem exists with 

the supplier setup. 

• Contact Procurement Services to speak with a Vendor File Coordinator. Inform them of 
the name of the Vendor/Supplier used on the requisition. They will research the issue.  

  

  

Rejected Requisitions 

  

Sometimes requisitions are rejected by Procurement, most often for missing documentation. Following is a 

list of reasons requisitions are rejected. 

  

• Three quotes were not provided 

• Item should have been purchased via a Payment Voucher and not a PO 

• A sole source form was not attached 

• A vendor has not registered in the system or the buyer is not informed 

• Did not use a Strategic Supplier but should have 

• Did not provide a copy of the Grant to show the vendor is named in the Grant 

• The Moving & Relocation did not include a vendor quote & Moving Agreement 

Reconciling Requisition Commitments 
Reconciling Requisition Commitments 

  

When requisitions are created, they create a commitment. Once the Purchase Order is created, 
the requisition commitment is relieved and a PO commitment is created. If the PO is not in an 
Approved Status, then the PO commitment will go away and the requisition commitment will 
return. 

There are certain reasons when you will see outstanding requisition commitments. Following is a 
list: 

• Incomplete requisition 

• Requisition has not been turned into a Purchase Order 

• Associated Purchase Order has not been Approved 

  

How do I deal with the above items and relieve the requisition commitment?  

Incomplete Requisition: 



Training Guide 

 
 

 

 Page 144 

Have the individual who originally prepared the requisition either complete (send forward for 
approval) or delete the requisition in iProcurement. 

However, if the individual is no longer at UVA post a request for assistance with requistion deletion on the 

HR-Finance User Group community forum at UVaCollab (http://www.hr.virginia.edu/other-hr-

services/employee-development/sys/issupport/) (http://www.hr.virginia.edu/other-hr-services/employee-

development/sys/issupport/) 

           

Requisition has not been turned into a Purchase Order: 

Wait for Procurement Services to create a Purchase Order. When that happens, then the 
requisition commitment will be released. 

  

Associated Purchase Order has not been Approved: 

Reapprove the Purchase Order associated with the requisition. This is done in the Integrated 
System, via Purchase Order Summary. 

Viewing and Printing in the Marketplace 

Upon completion of this section, you will be able to do the following in the UVA Marketplace:  

• Search for and view purchase orders 

• Print purchase orders 

Viewing Purchase Orders in the UVA Marketplace 

Procedure 

 
You can view your purchase orders in the UVA Marketplace, including Revisions, 

Approvals, Shipments, and History.  This section will show you how to view purchase 

orders in the UVA Marketplace. 

 

While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 

http://www.hr.virginia.edu/other-hr-services/employee-development/sys/issupport/
http://www.hr.virginia.edu/other-hr-services/employee-development/sys/issupport/
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Step Action 

1. Click on the Orders & Documents icon.  
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Step Action 

2. There are three search types.  

 

Search Documents by PO number, Date or Date Range, or just for those POs you 

created.  

 

View Saved Searches is similar to Favorites. You can create a search that you use 

often and save it for repeated use. 

 

My Forms will display forms that you have requested over the selected date range. 

 

Click the Search Documents link. 

 

3. In the drop-down list, you can search by Purchase Order.  

 

Note:  Do NOT select All Documents or Requisitions.  The requisition number is 

the SciQuest cart number and does not correspond to the University's requisition 

numbering system.  

4. You can search for a specific purchase order by entering the PO number in the 

search field.   

 

If you want to see all of your purchase orders, you can click on the Go to: my 

purchase orders link. 

5. In the drop-down list you can select the date range for the search.   
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Step Action 

6. For this example, you will search for all your purchase orders. 

 

Click on the Go to: my purchase orders link.   

 

7. The search results display. 

 

Note:  Do not use the requisition number listed on this page.  It is the SciQuest cart 

number and does not correspond to the University's requisition numbering system.   

8. You can refine the search results using available filters.  

 

You can view a listing of all purchase orders for a specific supplier by selecting the 

supplier.  

9. Click on the Beckman Coulter link. 

 

10. The purchase orders list displays. 

11. Click on the PO No link to view the purchase order. 

 

12. This Status page will show you the status of the purchase order. You can also view 

and print the original requisition, product details, and additional information about 

the supplier. 

13. You can use the directional arrows to move to the next purchase order on the search 

results list. 

14. You can use the Purchase Order Number(s) drop-down list to select a purchase 

order number that is further down the list.  This eliminates multiple clicks of the 

directional arrow. 
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Step Action 

15. Click on the Purchase Order tab. 

 

16. The Purchase Order tab will show you complete purchase order details, including 

shipping and billing information, and how the purchase order was delivered to the 

vendor. 

 

Click on the Revisions tab. 

 

17. The Revisions tab will show you the change history for the purchase order. 

 

Click on the PO Approvals tab. 

 

18. The PO Approvals tab will show you the approval hierarchy. 

 

Click on the Shipments tab. 

 

19. You will see any shipments that have been received for the order. 

 

Click on the Comments tab. 
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Step Action 

20. You will see any comments entered on the purchase order, or you can add a 

comment. 

 

Click on the Add Comment button. 
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Step Action 

21. Click on the Close button. 

 

 

 
 

Step Action 

22. Click on the Attachments tab. 
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Step Action 

23. The Attachments tab will show you any attachments entered on the purchase order. 

 

Click on the History tab. 

 

24. The History tab will show you the history of the purchase order. 

25. Congratulations!  You have completed the section on Viewing Purchase Orders 

in the UVA Marketplace. 

End of Procedure. 

Printing Purchase Orders in the Marketplace via Quick View 

Procedure 

 
Some vendors require you to print and deliver (via fax, mail, or in person) a paper purchase 

order.  In this section you will learn how to print purchase orders in the UVA Marketplace. 

 

You will first need to find the purchase order you want to print.  See "Viewing Purchase Orders 

in the UVA Marketplace" for instructions on finding purchase orders. 

 

While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 
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Step Action 

1. Click the Orders & Documents icon to search for the purchase order you wish to 

print. 

 

2. Click the Search Documents link. 
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Step Action 

3. Click in the search field. 
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Step Action 

4. Enter the purchase order number. 

 

For this example, the purchase order number has been entered for you. 

 

Click on the Go button. 

 

5. Click on the Quick View icon. 

 

6. This is the summary of the purchase order.   

 

You may print this for your own records, but this is not acceptable as a purchase 

order to deliver to the vendor.   

 

To print this for your own records, click on the Print button and follow the prompts 

to print. 

7. If you are required to deliver the purchase order to the vendor, you will want to print 

out the purchase order with the UVA logo.  The following instructions will show 

you how to do that. 
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Step Action 

8. Click on the purchase order (number) 1699307 link. 

 

 

 
 

Step Action 

9. Click on the Available Actions drop down LOV to view the list. 

 

10. Click on the Print Fax Version item. 

 

11. Click on the Go button and follow the prompts to print.  

 

Note:  Do not change print preference to landscape. 

 

12. This is the printable page that you can print and deliver to the vendor. 

 

Use the File >> Print to print this version. 

13. Another option to deliver the purchase order is by sending it by email to the vendor 

or sending a copy to yourself for your records, if needed. 

 

Depending on the version of Internet Explorer you have you can either use the page 

icon drop-down list and select 'Page by e-mail' or use the File menu 

(File>Send>Page by e-mail). 
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Step Action 

14. Congratulations!  You have completed the section on Printing Purchase Orders 

in the UVA Marketplace. 

End of Procedure. 

Receiving in iProcurement 

Receiving is required for any Purchase Orders totaling $5,000.00 and higher. Anyone with an 
active purchasing responsibility (PO Shopper, PO Requester, and PO Purchaser) can enter 
receiving information. 

  

The Receiving tab in iProcurement is the preferred location to enter receiving information. 

  

Upon completion of this section, you will be able to process the following receiving transactions in 
iProcurement:  

• Express receive items  

• Receive partial shipments  

• Return items 

• Correct receipts 

• View receipts 

Express Receiving in iProcurement 

Procedure 

 
System receiving is required for all purchase orders totaling $5,000.00 and greater. 

 

Express Receipt is a quick method of receiving ALL items on a purchase order at once. 

 

In this section you will learn how to process an Express Receipt. 

 

While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 
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Step Action 

1. Note that you can Express Receive from either the Shop or the Receiving tab in 

iProcurement.  

 

For this example, you will receive from the Shop tab. 

 

Click on the Express Receive icon. 

 

2. Click on the Submit button. 

 

3. You will get a confirmation that the receipt was created and will see the Receipt 

number. 

 

Remember to annotate the Receipt number on your packing slip, and maintain the 

packing slip for the period of time required for record retention. 

4. Congratulations!  You have completed the section on processing Express 

Receipts. 

End of Procedure. 

Receiving Items in iProcurement 

Procedure 

 
System receiving is required for all purchase orders totaling $5,000.00 and greater.   
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In this section you will learn how to process a partial receipt. 

 

While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 

 
 

Step Action 

1. Click on the Receiving tab. 

 

2. The Receiving tab displays. You will see two lists:  A list of Requisitions that 

require receiving, and a list of receipts that have been entered.  

 

Note: If you are entering receiving for a purchase order that you did not create, then 

change the Search Attribute to Find by Order Number. Next, enter the Purchase 

Order Number in the blank Search Value field, then click Go. 

3. You will see links to Receiving actions at the top.  Although you can click on the 

Receive Items link to receive, you will be prompted to search for the requisition if 

you click on that action link.  It is easier to go directly to the requisition in the 

Requisitions to Receive list. 

4. Click on the 1191398 link. 

 

5. Click on the Receive button. 
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Step Action 

6. Click on the Select button. 

 

7. Enter the exact number of items received. 

 

Enter the desired information into the Receipt Quantity field. Enter "1". 

8. Click on the Next button. 

 

9. The Receipt Date will default to the current date.  You should change this to the 

date the goods or services were actually received, if applicable. 

10. Important!  Use the calendar button to change the date if necessary. 

 

For this example, the Receipt Date is correct. 

11. Click on the Next button. 

 

12. Click on the Submit button. 

 

13. Congratulations!  You have completed the section on Receiving Items. 

End of Procedure. 

Returning Items in iProcurement 

Procedure 

 
Sometimes you will need to return items to the vendor.  This section will show you how to 

process a transaction to return items. 

 

While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 
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Step Action 

1. Click on the Return Items link. 
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Step Action 

2. A list displays all items eligible for return.  Locate the line for the item you wish to 

return.  

 

Click in the Return Quantity field.  

 

3. Enter the desired information into the Return Quantity field. Enter "1". 

 

 
 

Step Action 

4. Click on the Next button. 
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Step Action 

5. You must enter a reason for the return.   

 

Click on the List of Values icon to see reasons for the return. 
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Step Action 

6. Use the "%" to search for a list of return reasons. 

 

Click on the Go button. 

 

 

 
 

Step Action 

7. Find the reason in the list of values. 

 

Click on the Quick Select button for the Reason Name. 

 

8. Optionally, you may enter an RMA (Return Material Authorization) number or 

Comments regarding the return. 
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Step Action 

9. Click on the Next button. 

 

10. Click on the Submit button. 

 

11. Congratulations!  You have completed the section on Returning Items. 

End of Procedure. 

Correcting Receipts in iProcurement 

Procedure 

 
Sometimes you may enter the incorrect quantity on a receipt.  In this section you will learn 

how to correct receipts. 

 

While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 
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Step Action 

1. Click on the Correct Receipts link. 

 

2. For this example, the Received column states that 1 brake motor was received.  

Actually two were received.   

 

In the Correct Quantity field, enter the quantity that you actually received. 

 

Enter the desired information into the Correct Quantity field. Enter "2". 

3. Click on the Continue button. 

 

4. Click on the Submit button. 

 

5. Congratulations!  You have completed the section on Correcting Receipts. 

End of Procedure. 

Viewing Receipts in iProcurement 

Procedure 

 
In this section you will see how to view receipts. 

 

While taking the training, you may click on the Actions link in the upper right corner to restart 

the section, go to the next step, return to the previous step, close the topic, or initiate other 

actions. 
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Step Action 

1. Click on the Receiving tab. 

 

2. You may need to scroll down to see the section My Receipts at a Glance.  

 

There you will see your most recent receipts.  You can click on the Full List button 

to search for additional receipts. 
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Step Action 

3. You can click on the View Details icon to view receipt details.   

 

Click on the View Details icon. 

 

4. You will see the receipt details.  Notice that you can Return Items or Correct Receipt 

from this screen as well. 

5. Congratulations!  You have completed the section on Viewing Receipts. 

End of Procedure. 

Working with Vendors and Purchase Orders in the Integrated 
System 

IMPORTANT INFORMATION - READ ME FIRST 

  

Please consult the Purchasing training toolkit (http://www.hr.virginia.edu/other-hr-services/employee-

development/sys/po_ap-tk/) for additional information/help, including full printable training guides of the topics 

contained within this module. 

  

About Vendors 

In IS every vendor or individual receiving a non-payroll check must be listed in the vendor file. 

This includes vendors, employees, students, human subjects, student groups, etc. A tax 

identification number or social security number is mandatory. 

http://www.hr.virginia.edu/other-hr-services/employee-development/sys/po_ap-tk/
http://www.hr.virginia.edu/other-hr-services/employee-development/sys/po_ap-tk/
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• PO Requesters and PO Purchasers may add vendors using the Supplier Entry form in 
IS to record information about individuals and companies from whom goods and 
services are purchased. 

• Required vendor information includes vendor name, tax identification number or social 
security number, and site information for the vendor's addresses. Vendor name and 
tax IDs cannot be duplicated and must be unique. 

• When a vendor is entered that does business from multiple locations, vendor 
information such as vendor name, tax identification number, and minority status is 
entered only once, and supplier sites are entered for each location. 

• Most other vendor information (such as payment terms) automatically defaults to all 
sites. 

About Purchase Orders 

A PO is the agreement with a vendor (or supplier) for the purchase of goods and services when competition is required, 

generally for purchases greater than $5,000. POs can also be used to purchase restricted items. A current list of 

restricted items may be found on the Procurement Services website at www.virginia.edu/procurement 

(http://www.virginia.edu/procurement). 

  

Restricted items include:  

• any form of goods or services from an employee of the Commonwealth of Virginia. 

• alcoholic beverages, ammunition, automobiles, carpet, firearms, flowers, food, 
framing, gifts, prescription drugs, radioactive materials, renovation or construction 
services, security systems, tents (non-camping, purchase or rental) and window 
treatments. 

PO Requesters and PO Purchasers complete and approve purchase requisitions. The PO Buyer is responsible for 

issuing purchase orders. The Buyer Managers will assign requisitions to Buyers. It is the responsibility of the Buyer to 

review and approve the requisitions, and turn them into purchase orders. 

 
IS assigns both requisition and purchase order numbers, once the transaction is saved. There is no obvious relationship 

between the requisition number and the purchase order number. For example, requisition number 123 may be turned 

into purchase order #79451. You can easily find the purchase order number in IS if you know the requisition number or 

vendor name. 

  

  

Upon completion of this module, you will be able to:  

• Search for and enter suppliers 

• Work with purchase orders 

  

  

To start a simulation:  

  

1.  Double-click on "Departmental Purchasing".  

  

2.  Double-click on the section.  

http://www.virginia.edu/procurement


 

Training Guide 
 

 

 Page 169 

  

3.  Click on the topic for which you wish to view the simulation.     

  

4.  Click on "Try It" in the upper right-hand corner to interact with the simulation. Click on 
"Print It" to print out a Job Aid.   

Finding and Entering Suppliers 

Upon completion of this section, you will be able to: 
• Search for a supplier 
• Enter a supplier into the Vendor file 

Searching for a Supplier 

Procedure 

 
In this simulation you will search for a supplier in the vendor file. 

 

 

Step Action 

1. The Search page provides multiple fields for you to enter data and search for a 

supplier.  

 

Note:  You can use the percent sign (%) as a wildcard to narrow your search.  

 

Hint:  To ensure a faster search, enter the first few characters of the Supplier 

Name and the Taxpayer ID number, which is a unique identifier.    
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Step Action 

2. Enter the Supplier Name (last name, first name) if entering an individual or the 

company name.   

 

In this simulation, search for Alex Hayes. Remember to search on the last name 

first. 

 

Enter "Hayes%". 

3. The Taxpayer ID is a unique identifier. Enter the Taxpayer ID, without hyphens.   

 

In this example, enter "852369741". 

4. The Show More Options link allows you to search by supplier type, etc. Typically 

you won't need to use this.  

5. Click the Go button. 

 

6. In this example, no results were found.   

7. In this example, searching by Supplier Name without the Taxpayer ID yielded 

results. View information for Hayes Group. 

 

Click the View button. 

 

8. Information on the Suppliers Quick Update, Company Profile, Organization, 

Address Book, Contact Directory, and Approval History  are available to view. 
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Step Action 

9. Congratulations! You have completed the simulation on searching for a supplier in 

the vendor file. 

End of Procedure. 

Entering a Supplier into the Vendor File 

Search the system to verify the supplier is not in the vendor file prior to creating them.  
(See instructions in "Searching for a Supplier" topic). 

Procedure 

 
Note:  Remember that before you add a supplier you must first check to ensure that the supplier 

does not already exist in the vendor file (refer to topic Searching for a Supplier). 

 

In this simulation you will create a new supplier for inclusion in the vendor file. 

 
 

Step Action 

1. Begin by clicking on the Create Supplier button. 

 

2. The Create Supplier page displays. Any information you entered for the search 

does not carry over so you will have to re-enter that information.  

 

Note: Vendors must be entered using upper case letters, so ensure the Caps Lock 

button is turned on! 

 

Enter "HAYES, AMY" in the Supplier Name field. 
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Step Action 

3. Use the Special Status field only if you are paying one of the following special 

individuals or groups requiring an immediate payment: 

- Human subjects 

- Medical Center Employee 

- NRA UVA Fellows 

- Refunds 

- Research 

- UVA Fellows 

4. Enter the Taxpayer ID (without hyphens).   

 

Enter "852369741". 

5. Click the Apply button. 

 

6. The Update [Supplier name] Organization page displays, with the supplier's name 

and number defaulted.   

 

Click the Organization link to access the Taxpayer ID information. 

 

7. The Taxpayer ID displays. 

 

Do not change any information on this page. 

8. Next, enter supplier address information. 

 

Click on the Address Book link. 

 

9. The Update [Supplier name]: Address Book page displays. 

 

Since you are creating a new supplier, click the Create button. 

 

10. The Create Address: Confirm Details page displays. You must complete the fields 

marked with an asterisk. 

 

Country is a required field. It defaults to the United States.  Use the list of values 

drop down menu if you need to select a different country, for example when adding 

a foreign supplier or individual.   

11. Enter the supplier's address, beginning with Address Line 1. 

 

For this example, enter "165 MADISON AVENUE" in the Address Line 1 field.  
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Step Action 

12. Enter the City information. 

 

For this example, enter "NEW YORK" into the City field. 

13. Enter the State information.  

 

This is a free form field. 

 

Note:  Always enter the 2 character state code without spaces or punctuation, in all 

capital letters.   

 

Example:  NY (correct) 

                 N.Y. (incorrect) 

 

For this example, enter "NY" in the State field. 

14. Enter the Postal Code (zip code). 

 

For this example, enter "10016" in the Postal Code field.  

15. The Address Name field is the geographic location of the supplier. This name will 

also become your Site name. 

 

Naming conventions: 

-  This field allows 15 characters. 

-  Always use the city name (NEW YORK, NEW YORK01, NEW YORK02). 

16. Enter the Address Name. 

 

For this example, enter "NEW YORK" in the Address Name field. 

17. The Communication Details box is checked by default.   

 

Do not uncheck it. 

18. Add a phone number. 

 

For this example, enter "212" in the Phone Area Code field. 

19. For this example, enter "875-2256" into the Phone Number field.  

20. The Address Purpose defaults to Payment.   

 

No action is required on your part.  Accounts Payable will select additional 

address purposes as needed when they enter the vendor's registration information 

into the system. 

 

Note:  If the supplier is needed immediately for an order in the Marketplace, contact 

Accounts Payable (924-4212) for their assistance.   
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Step Action 

21. When you have completed entering address information, link the new address to a 

site. 

 

Click the Continue button. 

 

22. The Create Address: Site Creation page displays. Use this page to link the address 

to the site. 

 

Click the Select checkbox. 

 

 

 
 

Step Action 

23. Click the Apply button. 

 

24. The Update [Supplier name]: Address Book page displays. You can edit the 

information using the Update icon. You can also use the Details Arrow link to 

access address details.   

25. Next, add supplier contact information.  

 

Click on the Contact Directory link. 
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Step Action 

26. The Update [Supplier name]: Contact Directory page displays.   

 

Click the Create button. 

 

27. In this example, the contact information has been added for you. 

28. Click the Apply button. 

 

29. A contact created confirmation message displays. 

 

You can change contact information by selecting the Update icon.   

 

If other supplier information needs to be changed, use the menu bar on the left side 

of the screen and select the page to be changed.   

 

Important Note:  When you exit the supplier pages, you will not be able to update 

the information via the system. Instead, you will complete the Vendor Sites 

Add/Update for Departments form located on the Procurement and Supplier 

Diversity Services website.   

30. Congratulations!  You have completed the simulation for entering a supplier into the 

Vendor File. 

End of Procedure. 

Finding and Printing Purchase Orders in the Integrated System 

  

Upon completion of this section, you will be able to:  

• Find purchase orders  

• Print PDFs of purchase orders  

• View invoices 

Finding a Purchase Order 

Procedure 

 
In this simulation you will locate a purchase order. 
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Step Action 

1. From the UVA PO Purchaser menu on your Home page, navigate to the Find 

Purchase Order screen. 

 

Click the Purchasing link. 

 

2. Click the Purchase Orders link. 

 

3. Click the Purchase Order Summary link. 

 

4. Enter known criteria in the fields. The more information you include, the more 

restrictive the search. 

 

We recommend that you search either by purchase order Number or by Buyer 

name.  

5. You can also use the alternative region tabs to further restrict the search. 

6. If you don't know the purchase order number or the buyer's name but you do know 

the requisition number, choose the Related Documents tab and enter the number in 

the Requisition field. 
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Step Action 

7. Choose which summary window to display by selecting from the Results group 

(Headers, Lines, Shipments, or Distributions).  

 

Depending on the search criteria you have specified, not all summary windows may 

be available. 

 

In this exercise use the default, Headers. 

 

 
 

Step Action 

8. Enter the purchase order number. 

 

Enter the desired information into the Number field. Enter "1699307". 

9. Click the Find (J) button. 
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Step Action 

10. The summary window displays the Headers page. 

 

Information that is found on the Purchase Order Headers page includes; a 

description of the purchase order, the approval status, name of the supplier, dollar 

amount, and the matched amount of the purchase order.  

 

Click the Open button. 

 

11. The purchase order displays. 

12. Congratulations!  You have completed the simulation for finding a purchase order. 

End of Procedure. 

Printing a Purchase Order in the Integrated System 

You may need to print a copy of the Purchase Order to deliver the purchase order to the 
Supplier/Vendor (by fax) or to keep a copy for your records/file. 
  

Also, if the purchase order is ever revised, you must print and deliver (fax, email, etc.) the 
revised purchase order to the Supplier/Vendor. 

Procedure 

 
In this simulation you will see how to print a purchase order.  
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Step Action 

1. From the UVA PO Purchaser menu on your home page, navigate to the Submit a 

New Request screen. 

 

Click the Reports link. 

 

2. Click the Run link. 
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Step Action 

3. The Submit a New Request screen displays.  

 

Using the Single Request option (defaulted), click the OK button. 
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Step Action 

4. To run this request, choose the name from the list of values. 

 

Click the Name... (ellipsis) button. 

 

5. Highlight the UVA Printed Purchase Order Report - PDF row. 

6. Click the OK button. 

 

7. Enter parameters for the following fields by choosing appropriate selections from 

the list of values. 

 

Click the Print Selection...(ellipsis) button. 

 

8. Use the default All. 

 

Click the OK button. 

 

9. Now enter values in the Purchase Order Numbers From and To fields. 

 

Press [Tab]. 

10. Enter the desired information into the Purchase Order Numbers From field.  

 

This is a REQUIRED field. 

 

Enter "1699307". 

11. Press [Tab]. 

12. The To field auto populates with the value in the From field. 

 

Click the OK button. 

 

13. Click the Submit button. 
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Step Action 

14. The request is in the Pending phase.  

  

Click the Refresh Data button. 

 

15. Phase changes to Completed when the report has run. 

   

Click the View Output button. 
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Step Action 

16. This is an example of a purchase order that you could print (File>Print) and fax to 

the supplier/vendor to place the order for goods and/or services or print the purchase 

order if it has been revised. 

 

Press [Enter]. 

17. Congratulations!  You have completed the simulation for prining a purchase order in 

the integraed system. 

End of Procedure. 

Changing Purchase Orders 

After a PO has been approved the originator (Buyer) may change information on the PO if 
needed. Such a change may result in a PO revision, which designates a change to information 

that must be communicated to the vendor (such as delivery location or price).  

  

Before you begin:  

• We recommend that you don't change POs that have been invoiced. To verify that the 
PO has not been invoiced, navigate to Purchasing > Purchase Orders > Purchase 
Order Summary > Find Purchase Orders > Inquiry > View Invoices.  

• You must unreserve the PO prior to changing any pricing or PTAEO information. This 
releases the encumbrance. 

  

Before you begin answer the following questions: 
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Do you have the authority to change the PO?   

PO Purchaser, PO Requester, or PO Buyer responsibilities have the authority to change purchase orders. PO Shopper 

and AP/PO Viewer, however, cannot make changes.  

  

  

Is your name listed in the Buyer field on the PO?  

If yes, you can change the PO. If no, is the name listed in the Buyer field someone who works in your department or 

used to work there and is not there anymore? If this is the case, then you can replace their name with your name in the 

Buyer field and save. Re-query the PO to make changes to the PO.  

  

Note: If a Procurement Services' Buyer created the PO, then you should NOT change the Buyer field to your name. 

Instead, complete and submit a PO Change/Request form (on the Procurement Services website) to have Procurement 

Services make the change to the PO.  

  

After making your changes:  

• You must deliver the revised PO to the vendor/supplier. 

  

You can view changes between the original PO and the revised PO. Do this by clicking on PO Change History from the 

navigator form and entering the PO number you wish to view.  

Unreserving a Purchase Order Prior to Change 

You must unreserve the PO prior to changing any pricing or PTAEO information. This 
releases the encumbrance.  
  
If you are unreserving a PO that does not have any matched invoices, then follow the 
information provided in the topic called "Unreserving a Purchase Order Prior to 

Change". This is most often the case. 
  
However, there may be a need to change a PO that has a matched invoice which is on 
HOLD. For those instances only, follow the guidelines below. 
  
  

Unreserving a Purchase Order with a Matched Invoice on HOLD 

  
When attempting to unreserve a purchase order that has a matched invoice that has not 
been successfully validated (i.e., is on hold, missing receiving (QTY REC) or other reasons 

(Credit Memo)), then you will receive the following message:  
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Click the View Results button.  
  
Another window will open with additional details. If you see the result message of, “You 

cannot unreserve this document because there are outstanding invoices and/or 
credit memos”, this means that an invoice matched to the PO has not been validated 
(approved).  
  

  
  
If you receive this message, and your change to the PO is necessary and must be made 
immediately, you will need to contact Accounts Payable for assistance at 434-924-4212.  

In most cases, Accounts Payable staff will work with you to resolve the invoice that is on 
hold. Once that invoice is resolved, then your PO change can proceed.  In rare cases, 
where the invoice issue cannot be resolved and the PO change must be made, then the 
Accounts Payable staff will cancel the problem invoice and re-enter it once the PO revision 
is complete. If you have any questions about this, please contact Accounts Payable at 434-
924-4212.  

Procedure 

 
In this simulation you want to change a PO, so first you must unreserve it. 
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Step Action 

1. From the UVA PO Purchaser menu on your home page, navigate to the Find 

Purchase Order screen. 

 

Click the Purchasing folder. 

 

2. Click the Purchase Orders folder. 

 

 

 
 

Step Action 

3. Click the Purchase Order Summary link. 

 

 



 

Training Guide 
 

 

 Page 187 

 
 

Step Action 

4. Enter known criteria in the fields. The more information you include, the more 

restrictive the search. We recommend that you search either by purchase order 

Number or by Buyer name. 

 

In this example, locate the PO using the PO number. 

 

Enter the desired information into the Number field. Enter "1699307". 

5. Click the Find (J) button. 

 

6. Click the Open button. 

 

7. Note that the status is Approved, Reserved. 

 

Click the Tools menu. 

 

8. Click the Unreserve menu item. 
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Step Action 

9. Do NOT change the date. 

 

Unreserve the PO. 

 

Click the OK button. 

 

10. A confirmation message displays and the status is now Requires Reapproval. 

 

Click the OK button. 

 

11. You can now proceed with your changes. 

12. Congratulations!  You have completed the simulation for unreserving a PO prior to 

making changes. 

End of Procedure. 

Changing the Quantity on a Purchase Order 

Before you make changes:  

• We recommend that you don't change POs that have been invoiced. To verify that 
the PO has not been invoiced, navigate to Purchasing > Purchase Orders > 
Purchase Order Summary > Find Purchase Orders > Inquiry > View Invoices.  

• You must unreserve the PO prior to changing any pricing or PTAEO information. This 
releases the encumbrance. 

After making your changes:  

• You must deliver the revised PO to the vendor/supplier. 

• Note if the PO total is greater than $4999.99, then the PO will route to Procurement 
Services for additional approval. 

Procedure 

 
In this simulation you want to change the quantity of a PO line.  This may be an increase because 

you received more items than originally ordered, or a decrease if the vendor shipped/billed fewer 

items than ordered and the remaining quantity won't be shipped. 

 

Important: This exercise assumes that you have already verified that receiving has not been 

entered and/or invoices have not been keyed for the line. 



 

Training Guide 
 

 

 Page 189 

 
 

Step Action 

1. From your Home page, navigate to the Find Purchase Order screen. 

 

UVA PO Purchaser > Purchasing > Purchase Orders, click the Purchase Order 

Summary link. 
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Step Action 

2. Enter known criteria in the fields. The more information you include, the more 

restrictive the search. We recommend that you search either by purchase order 

Number or by Buyer name. 

 

In this example, locate the PO using the PO number. 

 

Enter the desired information into the Number field. Enter "1087540". 

3. Click the Find (J) button. 

 

4. Click the Open button. 

 

5. Important Note: 

 

You must unreserve the PO prior to changing any pricing or PTAEO information. 

(Tools > Unreserve > OK) 

 

In the simulation, this has already been done for you. 

6. Change the quantity by clicking in the Quantity field. 
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Step Action 

7. For this example, you received two items, whereas you only ordered one, but it is an 

item that you can use so you are going to keep it. 

 

Enter the desired information into the Quantity field. Enter "2". 

8. Click the Save button. 

 

You may or may not receive a confirmation message. 

 

9. Note the Status of "Requires Reapproval". 

 

Click the Approve button. 

 

10. If the PO total is greater than $4999.99, then the PO will route to Procurement 

Services for additional approval. 

 

It is important to add a comment in the Note field explaining what change(s) was 

made to the PO. Example: "Changed the quantity". 

 

Failure to add a comment could result in the PO being rejected. 

11. Click the OK button. 

 

12. Verify that the status of the PO is now Approved, Reserved. 

 

Important note: You must deliver the revised PO to the vendor/supplier. 

13. Congratulations!  You have completed the simulation for increasing the quantity on 

a PO. 

End of Procedure. 

Changing the Price on a Purchase Order Line 

Important Notes:  

• You should not change the price on a PO line that was created from a Hosted Catalog 
or a Punch-Out Catalog. 

• You can change the price on a PO line created using the Non-Catalog form. 

Before you make changes:   

• We recommend that you don't change POs that have been invoiced. To verify that 
the PO has not been invoiced, navigate to Purchasing > Purchase Orders > 
Purchase Order Summary > Find Purchase Orders > Inquiry > View Invoices.  

• You must unreserve the PO prior to changing any pricing or PTAEO information. This 
releases the encumbrance. 
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After making your changes:  

• You must deliver the revised PO to the vendor/supplier. 

• Note if the PO total is greater than $4999.99, then the PO will route to Procurement 
Services for additional approval. 

Procedure 

 
In this simulation you need to change the price on a purchase order line. 

 

Important: This exercise assumes that you have already verified that receiving has not been 

entered and/or invoices have not been keyed for the line. 

 
 

Step Action 

1. From your Home page, navigate to the Find Purchase Order screen. 

 

UVA PO Purchaser > Purchasing > Purchase Orders, click the Purchase Order 

Summary link. 
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Step Action 

2. Enter known criteria in the fields. The more information you include, the more 

restrictive the search. We recommend that you search either by purchase order 

Number or by Buyer name. 

 

In this example, locate the PO using the PO number. 

 

Enter the desired information into the Number field. Enter "1699307". 

3. Click the Find (J) button. 

 

4. Click the Open button. 

 

5. Important Note: 

 

You must unreserve the PO prior to changing any pricing or PTAEO information. 

(Tools > Unreserve > OK) 

 

In the simulation, this has already been done for you. 

6. Click in the Price field. 

 

7. Enter the desired information into the Price field. Enter "3049". 
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Step Action 

8. Click the Save button. 

 

9. Note the Status of "Requires Reapproval". 

 

Click the Approve button. 

 

10. Click the OK button. 

 

11. If the PO total is greater than $4999.99, then the PO will route to Procurement 

Services for additional approval. 

 

It is important to add a comment in the Note field explaining what change(s) was 

made to the PO. Example: "Changed the price". 

 

Failure to add a comment could result in the PO being rejected. 

12. Click the OK button. 

 

13. Verify that the status of the PO is now Approved, Reserved. 

 

Important note: You must deliver the revised PO to the vendor/supplier. 

14. This is an example of a standing purchase order.   

 

The department will receive multiple invoices for different dollar amounts as the job 

is completed.  

 

Notice the Quantity and Price fields are reversed from how a purchase order 

normally looks (Qty = 1, Price = 300). 

15. Congratulations!  You have completed the simulation for changing the price on a 

purchase order line. 

End of Procedure. 

Adding a New Line to an Existing Purchase Order 

Before you make changes:  

• We recommend that you don't change POs that have been invoiced. To verify that 
the PO has not been invoiced, navigate to Purchasing > Purchase Orders > 
Purchase Order Summary > Find Purchase Orders > Inquiry > View Invoices.  

• You must unreserve the PO prior to changing any pricing or PTAEO information. This 
releases the encumbrance. 

After making your changes:  
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• You must deliver the revised PO to the vendor/supplier. 

• Note if the PO total is greater than $4999.99, then the PO will route to Procurement 
Services for additional approval. 

Procedure 

 
In this simulation you want to add another item to an existing purchase order. 

 

Important: This exercise assumes that you have already verified that receiving has not been 

entered and/or invoices have not been keyed for the line. 

 

 

Step Action 

1. This simulation begins at the summary page of a PO. 

 

Important Note: 

 

You must unreserve the PO prior to changing any pricing or PTAEO information. 

(Tools > Unreserve > OK) 

 

In the simulation, this has already been done for you. 

 

 
 

Step Action 

2. At the next available line, click in the Type field. 
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Step Action 

3. Click again to change the defaulted value. 

 

Click in the Type field. 
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Step Action 

4. You can use two methods to complete the needed fields on this line. 

(1) You can click the ellipsis (...) to select from the list of values (LOV). 

(2) Or you can copy the previous line's entry by pressing Shift + F5. 

 

In this example you wish to copy the previous line. Press [Shift+F5]. 

5. Click in the Category field. 

 

6. Press [Shift+F5]. 
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Step Action 

7. Click in the Description field. 
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Step Action 

8. You can type the description or copy the description from the line above and edit it. 

 

In this example, copy and edit. 

 

Press [Shift+F5]. 

9. In this example you only need to change the TENV 7 to TENV 8. 

 

Highlight the text. 

10. Enter the desired information into the Description field. Enter "8". 

11. Press [Tab]. 

12. You can click the ellipsis (...) to select from an LOV or (in this example) copy the 

text from the line above.  

 

Press [Shift+F5]. 

13. Press [Tab]. 

14. Enter the desired information into the Quantity field. Enter "1". 

15. Press [Tab]. 

16. Enter the amount in the Price field or (as in this example) copy from the line above.  

 

Press [Shift+F5]. 

17. Now enter the PTAEO information. 

 

Click the Shipments button. 

 

18. Click the Distributions button. 

 

19. In the Project tab, enter the PTAEO information and date. Example data has been 

added here for you. 

20. Save your work and return to the summary page to approve the PO. 

 

Click the Save button. 

 

21. Click the Close button. 

 

22. Click the Close button. 
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Step Action 

23. Click the Approve... button. 

 

24. If the PO total is greater than $4999.99, then the PO will route to Procurement 

Services for additional approval. 

 

It is important to add a comment in the Note field explaining what change(s) was 

made to the PO. Example: "Added a new line". 

 

Failure to add a comment could result in the PO being rejected. 

25. Click the OK button. 

 

Important note:  You must deliver the revised PO to the vendor/supplier. 

 

26. Congratulations!  You have completed the simulation for adding a new line to an 

existing PO. 

End of Procedure. 

Canceling a Purchase Order Line 

If receiving has not been entered and/or invoices have not been keyed for a purchase 
order line, you can cancel it using one of two methods:  
  

1. By opening the purchase order and selecting Tools > Cancel. Do not unreserve the PO 
prior to changing. It must be in an Approved status. 

2. Prior to opening the purchase order, you can select Tools > Control and perform a 
Cancel action. Do not open the PO to use this method: if you open the document to cancel 
the line, the line returns to a requisition rather than canceling the line completely.  
  
Either method of canceling is irrevocable.  
  
  

Before you make changes:  

• To verify that the PO has not been invoiced, navigate to Purchasing > Purchase 
Orders > Purchase Order Summary > Find Purchase Orders > Inquiry > View 
Invoices.  

After making your changes:  

• You must deliver the revised PO to the vendor/supplier. 

Procedure 

 
In this simulation you wish to cancel a purchase order line.  

 

Important: This exercise assumes that you have already verified that receiving has not been 

entered and/or invoices have not been keyed for the line. 
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Step Action 

1. From your Home page, navigate to the Find Purchase Order screen. 

 

UVA PO Purchaser > Purchasing > Purchase Orders, click the Purchase Order 

Summary link. 
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Step Action 

2. Enter known criteria in the fields. The more information you include, the more 

restrictive the search. We recommend that you search either by purchase order 

Number or by Buyer name. 

 

In this example, locate the PO using the PO number. 

 

Enter the desired information into the Number field. Enter "1699301". 

3. Click the Find (J) button. 

 

4. Decision: Please make a selection from the options listed below. 

• Cancel the Line 

Go to step 5 

• Cancel from the Summary screen 

Go to step 16 

5. Do not click the Open button. 

 

Click the Lines button. 
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Step Action 

6. In order to activate it, click in any field on the line you wish to cancel. 

 

Click in the Item field. 

 

7. Click the Tools menu. 

 

8. Click the Control menu. 

 

9. Verify that the Actions field is defaulted to Cancel PO Line. 

 

Enter explanation text in the Reason field. In this example, text has been added for 

you. 

10. Click the OK button. 

 

11. A caution dialog box displays. Click the OK button. 

 

12. A confirmation message displays. Click the OK button. 

 

13. As needed, you can requery the PO using the Lines button to verify that the control 

action completed successfully. 

14. Important Note: 

 

You must deliver the revised PO to the vendor / supplier. 

15. Congratulations!  You completed the simulation on two ways to cancel a purchase 

order line. 

End of Procedure. Remaining steps apply to other paths. 
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Step Action 

16. Click the Open button. 

 

17. Important Note: 

 

To cancel a purchase order line you do not unreserve the PO. The PO must be in an 

Approved status. 

18. In order to activate it, click in any field on the line you wish to cancel. 

 

Click in the Item field. 

 

19. Select Tools > Cancel to cancel the line. 

 

Click the Tools menu. 

 

20. Click the Cancel menu. 

 

21. Verify that the Actions field is defaulted to Cancel PO Line. 

 

Enter explanation text in the Reason field. In this example, text has been added for 

you. 
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Step Action 

22. Click the OK button. 

 

23. A caution dialog box displays. Click the OK button. 

 

24. The line has been removed from the PO.  

 

If the Status field says "Requires Reapproval", you must Reapprove the PO by 

clicking the Approve button. 

 

If the Status field says "Approved, Reserved", you can close by hitting the "x" in the 

upper right corner. 

 

Press [Enter] to continue. 

 

25. If you needed to Reapprove your order, you must approve the document. 

 

Click the OK button. 

 
Go to step 14 

Changing PTAEO Information 

  
Before you make changes:  

• We recommend that you don't change POs that have been invoiced. To verify that 
the PO has not been invoiced, navigate to Purchasing > Purchase Orders > 
Purchase Order Summary > Find Purchase Orders > Inquiry > View Invoices.  

• You must unreserve the PO prior to changing any pricing or PTAEO information. This 
releases the encumbrance. 

After making your changes:  

• You do NOT need to deliver the revised PO to the vendor/supplier. 

• Note if the PO total is greater than $4999.99, then the PO will route to Procurement 
Services for additional approval. 

Procedure 

 
In this simulation you wish to change PTAEO information by charging remaining quantities to a 

new PTAEO. 
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Important: This exercise assumes that you have already verified that receiving has not been 

entered and/or invoices have not been keyed for the line. 

 

This type of change is needed when the original PTAEO has become invalid (end dated), is 

incorrect, or is low on funding. 

 
 

Step Action 

1. From your Home page, navigate to the Find Purchase Order screen. 

 

UVA PO Purchaser > Purchasing > Purchase Orders, click the Purchase Order 

Summary link. 
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Step Action 

2. Enter known criteria in the fields. The more information you include, the more 

restrictive the search. We recommend that you search either by purchase order 

Number or by Buyer name. 

 

In this example, locate the PO using the PO number. 

 

Enter the desired information into the Number field. Enter "1699298". 

3. Click the Find (J) button. 

 

4. Important Note: 

 

Before changing or entering new PTAEO information you must verify whether or 

not the PO has been invoiced or received against. 

 

Click the Inquire menu. 

 

5. Click the View Shipments menu. 

 

6. The Purchase Order Shipments screen opens. Scroll to view the Quantity fields. 

 

Click the horizontal scrollbar. 
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Step Action 

7. Annotate the number found in each of the columns. You will use this information 

later. 

 

In this example, Quantity Billed = 0. 

  

Click the Open button. 

 

8. Important Note: 

 

You must unreserve the PO prior to changing any pricing or PTAEO information. 

(Tools > Unreserve > OK) 

 

In the simulation, this has already been done for you. 

 

 
 

Step Action 

9. Click on the purchase order line you wish to change to activate the purchase order 

line.  

 

Click in the Item field. 
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Step Action 

10. Click the Shipments button. 

 

11. Click the Distributions button. 

 

12. First click in the line you wish to change. In this example there is only one line, so it 

is active by default. 

 

Scroll to the Quantity field. 

 

Click the horizontal scrollbar. 

 

13. Click in the Quantity field. 

 

14. You will be charging one of the items to a different PTAEO.  Change the quantity. 

In this example, change 2 to 1. 

 

Enter the desired information into the Quantity field. Enter "1". 
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Step Action 

15. Click anywhere in the next available line to enter the new PTAEO information for 

any remaining quantity balances. 

 

Click a field in the second line. 

 

16. Enter the new PTAEO information or use the ellipsis (...) to search for values. You 

can also use Shift + F5 to copy values from the line above. 

 

Enter the desired information into the Project field. Enter "101937". 

17. Press [Tab]. 

18. Enter the desired information into the Task field. Enter "101". 

19. Press [Tab]. 

20. Enter the desired information into the Award field. Enter "SS00044". 

21. Press [Tab]. 

22. Press [Shift+F5]. 

23. Press [Tab]. 

24. Press [Shift+F5]. 

25. Press [Tab]. 

26. Enter today's date. 

 

Click the Date... (ellipsis) button. 

 

27. The calendar displays today's date by default. 

 

Always use the default date.  Do not change it! 

 

Click the OK button. 

 

28. Important Note: 

 

Verify that the quantity of the distribution lines equals the original quantity amount 

for the purchase order line. 

 

In this example, the quantity for Distributions line one is 1 (original PTAEO 

distribution line one) + 1 remaining (new distribution line two) = 2 (total quantity 

ordered for this purchase order line). 
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Step Action 

29. Save your changes before exiting the screen. 

 

Click the Save button. 

 

30. Return to the summary screen. 

 

Click the Close button. 

 

31. Click the Close button. 

 

32. Repeat the steps for each purchase order line requiring a PTAEO change.  

 

Reapprove the PO when you have finished making changes. 

 

Note: If the PO total is greater than $4999.99, then the PO will route to Procurement 

Services for additional approval. 

 

Click the Approve button. 

 

33. If the PO total is greater than $4999.99, then the PO will route to Procurement 

Services for additional approval. 

 

It is important to add a comment in the Note field explaining what change(s) was 

made to the PO. Example: "Changed the PTAEO". 

 

Failure to add a comment could result in the PO being rejected. 

34. Click the OK button. 

 

35. Congratulations!  You have completed the simulation for changing PTAEO 

information on a PO when the original PTAEO has become invalid (end dated), is 

incorrect, or is low on funding. 

End of Procedure. 

Correcting the Accounting Date (Invalid GL Date) in the Integrated System 
(PO) 

Procedure 

 
In this simulation you are in the process of submitting a purchase order for approval when you 

encounter an error message indicating an invalid GL date. 
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Step Action 

1. When you click the Approve button... 

 

2. An error message indicates there is an invalid GL date. This happens when a PO is 

created and approved in two different GL periods. 

  

Click the OK button. 

 

3. To correct the problem, enter a valid GL date.  

 

Click the Shipments button. 

 

4. Click the Distributions button. 

 

5. Click the Destination tab. 

 

6. Scroll to the GL Date field. 

 

Click the horizontal scrollbar. 
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Step Action 

7. Delete the existing date and enter today's date. 

 

Click in the GL Date field. 

 

8. Press [Delete]. 

9. Click the GL Date button. 

 

10. The calendar defaults to today's date. 

 

Always use the default date.  Do not change it! 

 

Click the OK button. 

 

11. Save your change. 

 

Click the Save button. 

 

12. Now return to the summary page and submit the approval. 

 

Click the Close button. 

 

13. Click the Close button. 
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Step Action 

14. Click the Approve button. 
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Step Action 

15. Click the OK button. 

 

16. Congratulations!  You have completed the steps for correcting an invalid GL date. 

End of Procedure. 

Controlling Purchase Orders 

Before you begin:  

Answer the following sequence of questions to determine if you can control the Purchase 

Order.  

  

1.  Is your name listed in the Buyer field on the purchase order? If yes, you can control the PO. 

  

2.  If you answered “no”, answer the following question: “Is the name listed someone who currently works 

in your department or who used to work there and is no longer there anymore? 

  

If yes, consult with the person who is listed as the Buyer.  If they have left the department, you may replace 

their name with your name in the Buyer field.  Following are instructions on how to replace the Buyer 

name: 

• Open the PO 

• Delete the name currently in the Buyer field 

• Enter your name in the Buyer field (last, first) 

• Save your work 

• Click the [OK] button 

• Reapprove the PO 

• Click the [OK] button 

• Re-query the PO (PO Summary, Find, do not OPEN it) 

  

If no, is the name listed a buyer in Procurement Services? If yes, then the PO was created by a Central 

Buyer in the Procurement and Supplier Diversity Services department. You should NOT change the Buyer 

field to your name! Instead, complete the PO Change Request form found on the Procurement and Supplier 

Diversity Services website. The Central Buyer will control the PO for you. 

Controlling a Purchase Order 

Before you make changes:    

• We recommend that you verify that the PO has been paid.  Navigate to Purchasing > 
Purchase Orders > Purchase Order Summary > Find Purchase Orders > Inquiry > 
View Invoices.  

• Verify that you are listed as the Buyer for the PO. 
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After making your changes:  

• You must deliver the revised PO to the vendor/supplier. 

Procedure 

 
In this simulation, you will see how to control a purchase order you created.  

 
 

Step Action 

1. From your Home page, navigate to the Find Purchase Order screen. 

 

UVA PO Purchaser > Purchasing > Purchase Orders, click the Purchase Order 

Summary link. 
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Step Action 

2. Enter known criteria in the fields. The more information you include, the more 

restrictive the search. We recommend that you search either by purchase order 

Number or by Buyer name. 

 

In this example, locate the PO using the PO number. 

 

Enter the desired information into the Number field. Enter "1699306". 

3. Click the Find (J) button. 
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Step Action 

4. First verify that your name is listed in the Buyer field. If it isn't, you can't control the 

purchase order.  

 

Click the horizontal scrollbar. 

 

5. In this example your name is listed in the Buyer field.  

 

Now you can access the Control Document screen. Click the Tools menu. 
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Step Action 

6. Click the Control menu. 

 

7. Select the appropriate action. 

 

Cancel PO - This action cancels the Purchase Order. Use this control type when you 

have selected a wrong Vendor for the Supplier field on your purchase order. Also, if 

there has not been any invoicing/activity against the purchase order and you wish to 

cancel the purchase order. This action is irrevocable.  

 

Close - You can close the purchase order at the header, line, and shipment levels. 

  

Close for Invoicing - You can close for invoicing at the header, line, and shipment 

levels. If you close for invoicing a purchase order header that is currently open, 

Purchasing sets the status of all Purchase Order shipments to Closed for Invoicing, 

but the Purchase Order lines and header remain open. This status will not prevent 

you from matching an invoice to the purchase order.  

8. Finally Close – Use this control to prevent further actions on your PO. Only the 

Buyer listed on the PO has the ability to Finally Close the PO. Review all invoices 

to verify they have been paid. If you are using encumbrance or budgetary control, 

Finally Close automatically creates credit encumbrance journal entries in your 

general ledger system to reverse the encumbrance that corresponds to the Purchase 

Order and GA header, lines, or shipments you are closing. This action is 

irrevocable. 

 

If Finally Close is NOT listed, then you are not the Buyer (you do not own the 

PO), therefore you cannot Finally Close it.  
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Step Action 

9. Finally Close – Inactive Supplier Site 

A purchase order cannot be finally closed if the supplier site is inactive. Therefore, 

use the following work around. 

 

•Open and unreserve the PO. The inactive supplier site should not be grayed out. 

•Change the supplier site to an active site. If the Ship-To location disappears, re-

enter it. 

•Save your changes. 

•Reapprove and close the PO. 

 

Proceed with Finally Closing the purchase order.  

10. Freeze - You can freeze only at the header level. Freeze a PO when you want to 

prevent any future modifications to it. When you freeze a PO you can still receive 

and pay for goods you already ordered. If you want to prevent future receipt or 

matching invoices against this PO, cancel or finally close the PO instead.  

 

On Hold - You can place a PO on hold only at the header level.  This unapproves 

the PO while preventing printing, receiving, invoicing, and future approval until you 

remove the hold.  

11. Open - You can open a PO at the header, line, and shipment levels. 

  

Open for Invoicing - You can reopen for invoicing at the header, line, and shipment 

levels.  

 

Open for Receiving - You can reopen for receiving at the header, line, and 

shipment levels.  

 

Release Hold - You can release a hold only at the header level.  

 

Unfreeze - You can unfreeze only at the header and release levels.  

12. You should also enter a reason for the action. The Reason field is a free text field 

for entering any information you want to include. 

 

An example reason has been added for you. 
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Step Action 

13. Complete the action. 

 

Click the OK button. 
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Step Action 

14. For some control actions, you will receive messages related to the inability to undo 

the control action once it has been done.  

 

Click the OK button. 

 

15. You may be given additional warning messages to make sure that you want to 

proceed. 

 

Click the OK button. 

 

16. A confirmation note displays at completion of the control action.  

 

Click the OK button. 

 

17. Congratulations!  You have completed the simulation for controlling a purchase 

order. 

End of Procedure. 

Purchase Requisitions in the Integrated System 

Upon completion of this section, you will be able to:  

• Find a requisition  

• Print a requisition 

Finding a Requisition 

Procedure 

 
In this simulation you will locate a requisition. 
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Step Action 

1. To find a requisition, you must first go to the Requisition Summary.   

 

UVA PO Purchaser >> Purchasing >> Requisitions >> Requisition Summary. 

 

Click the Requisition Summary link. 

 

2. Enter known criteria in the fields. The more information you include, the more 

restrictive the search. 

 

We recommend that you search either by Requisition Number or by Preparer 

name.  

3. You can also use the alternative region tabs to further restrict the search. 

4. If you don't know the requisition number or the preparer's name but you do know the 

purchase order number, choose the Related Documents tab and enter the number in 

the Purchase Order field. 

5. Choose which summary window to display by selecting from the Results group 

(Headers, Lines, Shipments, or Distributions).  

 

Depending on the search criteria you have specified, not all summary windows may 

be available. 

 

In this exercise use the default, Headers. 
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Step Action 

6. Click in the Requisition Number field. 

 

7. Enter the example requisition number. 

 

Enter the desired information into the Requisition Number field. Enter "1191381". 

8. Click the Find (B) button. 

 

9. The Requisition Headers Summary window displays. 

 

You cannot open the requisition. 
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Step Action 

10. Click the Lines button to view the requisition. 
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Step Action 

11. The Requisition Lines Summary page displays.  There are two lines.   

 

You can scroll across to view the requisition information. 

 

Click the Close button. 

 

 

 
 

Step Action 

12. Click the Close button. 

 

13. Congratulations, you have completed the simulation for finding a requisition. 

End of Procedure. 

Printing a Requisition 

Procedure 

 
In this simulation, you will see how to print a requisition. 
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Step Action 

1. To print a requisition, you must first run a report, and then use the print option. 

 

UVA PO Purchaser >> Purchasing >> Reports >> Run 

 

Click the Run link. 
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Step Action 

2. The Submit a New Request screen displays.  

 

Using the Single Request option (defaulted), click the OK button. 

 

3. To run this request, choose the name from the list of values. 

 

Click the Name... (ellipsis) button. 

 

4. Highlight the Printed Requisitions Report row. 

 

5. Click the OK button. 

 

6. Now enter values in the Requisition Numbers From and To fields. 

7. Enter the desired information into the Requisition Numbers From field. Enter 

"1191381". 

8. Press [Tab]. 

9. Enter the desired information into the Requisition Numbers To field. Enter 

"1191381". 
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Step Action 

10. Click the OK button. 

 

11. Click the Submit button. 

 

12. The request is in the Pending phase.   

Click the Refresh Data button. 

 

13. Phase changes to Completed when the report has run. 

 

Click the View Output button. 

 

14. This is an example of a requisition you could print (File>Print) for your records.   

15. Congratulations!  You have viewed the simulation on how to print a requisition. 

End of Procedure. 

Working with Payments and Invoices 

Upon completing this section you should be able to: 

• Find payments 

• View invoices 

• Run Invoice on Hold Reports 

• Release invoice holds 

• Cancel invoices 

Finding Payments 

Procedure 

 
In this simulation, you will learn how to find a payment. 
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Step Action 

1. Click on UVA AP/PO Viewer to navigate to Payments. 
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Step Action 

2. Click on Payments. 

 

3. The Find Payments page displays.   

 

Search for a payment by entering known data : 

Payment - check number 

Payee - Individual or Supplier receiving the payment 

Voucher Audit -  Payment Voucher number 

Status - Status, Dates, and Accounted 

 

 
 

Step Action 

4. For this example, search by Payment Number (check number). 

 

Enter the desired information into the Payment: Numbers field. Enter "6024707". 

5. Press [Tab]. 
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Step Action 

6. Click the Find button. 

 

7. The Payments page displays. 

 

You can see the following information: 

Invoice number (205829) 

Date of the payment (28-OCT-2010) 

Amount ($13,134.28) 

GL Date (28-DEC-2010) 

Payment Amount ($13,134.28) 

8. You may also access the Payment Overview and Invoice Overview pages. 

9. Click the Payment Overview button. 

 

10. The Payment Overview page displays. 

 

Information pre-populates from the Payments page.   

 

Also provided is the Taxpayer ID and the Status of the payment.   

 

For this example, the Status of the Payment is Negotiable.   

11. The Invoices area list all invoices (by Invoice Number) paid with this payment.   

 

In this example, there is only one invoice. 
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Step Action 

12. Click the Invoice Overview button. 

 

13. The Invoice Overview page displays. 

14. Click the Close button. 

 

 

 
 

Step Action 

15. Click the Close button. 

 

16. Congratulations!  You have completed the simulation on how to find a payment. 

End of Procedure. 

Viewing an Invoice 

Procedure 

 
In this simulation you want to view an invoice. 
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Step Action 

1. From your Home page, navigate to the Find Purchase Order screen. 

 

UVA PO Purchaser > Purchasing > Purchase Orders, click the Purchase Order 

Summary link. 
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Step Action 

2. Enter known criteria in the fields. The more information you include, the more 

restrictive the search. We recommend that you search either by purchase order 

Number or by Buyer name. 

 

In this example, locate the PO using the PO number. 

 

Enter the desired information into the Number field. Enter "1087478". 

3. Click the Find (J) button. 

 

4. Instead of opening the PO, click the Inquire menu. 
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Step Action 

5. Click the View Invoices list item. 
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Step Action 

6. The invoice displays.  Here you can view the invoice date, supplier name, amount, 

payment status, po number, receipt, and attachments (if there are any). 

 

You can also view linked information. 

 

Click the Invoice link. 

 

7. Invoice information displayed includes general and payment details, an amount 

summary, and access to three tabs (Invoice Lines, Scheduled Payments, and Hold 

Reasons) for additional information. 

 

 
 

Step Action 

8. Click the Scheduled Payments tab. 
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Step Action 

9. Click the Hold Reasons tab. 

 

10. If the invoice is on hold, then the reason would be listed here. 

 

For this example, the invoice is not on hold.    

11. To exit the Invoice page, click the Return to Requisitions link. 

 

12. Congratulations!  You have completed the simulation for viewing an invoice. 

End of Procedure. 

Invoices - Running Invoices on Hold Report 

Procedure 

 
In this simulation you will see how to run the Invoices on Hold report. 
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Step Action 

1. To access the report: 

 

UVA AP/PO Viewer >> Other >> Run 

 

Click the Run list item. 

 

2. Click the OK button. 

 

3. Click the Name list of values drop down button. 

 

4. Click the Invoice on Hold Report row. 

5. Click the OK button. 
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Step Action 

6. Enter information as desired on the Parameters page. 

 

No fields are required.   

 

Dates must be entered in the DD-MM-YY format. 

 

Click the OK button. 

 

7. Click the Submit button. 

 

8. The report Phase is Pending. 

Click the Refresh Data button. 

 

9. The report Phase is Running.  

 

Click the Refresh Data button. 

 

10. The phase status is now Completed. 

 

Click the View Output button. 

 

11. Congratulations!  You have completed the simulation to see how to run the Invoices 

on Hold report. 

End of Procedure. 

Invoices - Releasing Invoice Holds 

Procedure 

 
In this simulation you will see how to release an invoice hold so the invoice can be paid. 
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Step Action 

1. To access the required area: 

 

UVA AP/PO Viewer >> Invoices >> Invoices 

  

Click the Invoices button. 

 

2. You may search for the invoice by entering either the Trading Partner name, the 

Invoice Number, or the Voucher Number. 

  

Click the Find button. 

 

3. Review the Holds placed on the invoice. 

 

Click the 3 Holds tab. 

 

4. Choose a Release Name. 

 

Click in the Release Name field. 

 

5. Click the Release Name list of values button. 
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Step Action 

6. Click the NRA Released row. 

 

7. Click the OK button. 

 

8. Click the Actions... 1 button. 

 

9. Click the Invoice Actions Validate  checkbox. 

 

10. Click the OK button. 

 

11. The invoice status is Validated.  The Trading Partner will be paid. 

12. Congratulations!  You have completed the simulation to see how to release an 

invoice hold so the invoice can be paid. 

End of Procedure. 

Invoices - Canceling Invoices 

Procedure 

 
In this simulation you will see how to cancel an invoice. 
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Step Action 

1. To access the required area: 

 

UVA AP/PO Viewer >> Invoices >> Invoices 

 

Click the Invoices button. 

 

2. Click in the Trading Partner: Name field. 

 

3. Enter the desired information into the Trading Partner: Name field.  

 

Enter "Larche". 

4. Press [Tab]. 

5. The Trading Partner's Supplier Number and Taxpayer ID defaults. 

 

Click the Find button. 

 

6. Click the Attachments...(paperclip) icon. 

 

7. Click in the Category field. 

 

8. Enter the desired information into the Category field.  

 

Enter "m". 

9. Press [Tab]. 

10. Miscellaneous is selected. 

 

Click the OK button. 

 

11. The Title field is an optional free-form field.   

 

You may enter either a Title or a Description or both. 

12. For this example, you will enter a Description. 

 

Click in the Description field. 
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Step Action 

13. Enter the desired information into the Description field.  

 

Enter "Canceling Invoice". 

14. Press [Tab]. 

15. Click the Data Type list of values. 

 

16. Click the Short Text row. 

 

17. Click the OK button. 

 

18. Enter the desired information into the Short text Multiline field.  

 

Enter "Enter reason for canceling invoice.". 

19. Click the Save icon. 

 

20. Click the Close icon. 

 

21. You will need to "refresh" your screen in order to see the attachment (yellow paper 

under the paperclip icon).  Following is one method to refresh your screen. 

 

Click in the PO Number field. 

 

22. Click in the PO Number field. 

 

23. Notice the yellow paper is visible under the paperclip icon now. 

 

Click the Actions... 1 button. 

 

24. Click the Cancel Invoices checkbox. 

 

25. Click the OK button. 
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Step Action 

26. Click the OK button. 

 

27. Notice the Note.  This invoice is on Hold.  Before you can cancel it, release the hold. 

 

Click the OK button. 

 

28. Click the 3 Holds tab. 

 

29. Click in the Release Name field. 

 

30. Click the Release Name list of values drop down  menu. 

 

31. Click the NRA Released row. 

 

32. Click the OK button. 

 

33. Click the Actions... 1 button. 

 

34. Click the OK button. 

 

35. Click the 1 General tab. 

 

36. Notice the Status of the Invoice is Cancelled. 

37. Congratulations!  Youhave completed the simulation to see how to cancel an 

invoice. 

End of Procedure. 

Receiving in the Integrated System 

IMPORTANT INFORMATION - READ ME FIRST  

  

Please consult the Purchasing training toolkit (http://www.hr.virginia.edu/other-hr-services/employee-

development/sys/po_ap-tk/) for additional information/help, including full printable training guides of the topics 

contained within this module.  

http://www.hr.virginia.edu/other-hr-services/employee-development/sys/po_ap-tk/
http://www.hr.virginia.edu/other-hr-services/employee-development/sys/po_ap-tk/
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Receiving Overview 

There is no central receiving department at the University of Virginia. Vendors ship or deliver goods directly to the site 

specified on the purchase order. Delivery location codes are recorded on the purchase order to specify the site to which 

goods should be delivered or shipped.  

 
Receiving must be recorded on-line in IS for all purchases $5,000 and greater. System receiving is not required for the 

purchase of restricted items less than $5,000. 

 
Document the receipt of all goods and services by signing and dating a packing slip or receipt. Maintain the 

documentation for three (3) years plus the current fiscal year. You must maintain grants documentation for a longer 

period of time. Check with your grant administrator for information on record retention requirements for grants 

documentation. 

  

Receiving Responsibilities  

The PO Receiver is responsible for:  

• refusing, accepting, and rejecting deliveries 

• notifying Accounts Payable to stop payment when there is a problem with goods or 
services received for purchases where the total dollar amount is less than  $5,000 

• completing receiving in IS for purchases $5,000 and greater 

Note on Recording PO Numbers:  

When you receive goods, you must record the corresponding PO number on the shipping documents, if it is not already 

shown. You may need to find the PO for the goods received to locate the number.  

  

  

Upon completion of this module, you will be able to:  

• Receive goods and services in IS 

  

Use these instructions to receive against POs for goods or services $5,000 and greater created prior to the Marketplace 

(prior to 12/4/2006).  

  

Note: You may enter receiving in iProcurement (Receiving tab - Receive items) for POs created in the Marketplace. 

Use the Marketplace training guide for instructions on how to receive in iProcurement.  

  

Comparing Items Ordered with Items Received 

After recording the purchase order number on the shipping documents, you must determine whether the correct 

material and quantity was received. Compare the items and quantities received with those ordered.  

 
Entering Receiving Information 
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After comparing the items and quantities received, you must enter the receiving information in IS. You can receive 

part of a purchase order, process multiple distributions, or use express receiving. 

  

You must contact the vendor if there is a problem with the order, such as:  

• the items received differ from those ordered 

• the quantity received is less than the quantity ordered 

• the University's on-time delivery specifications were not met 

• the goods are damaged 

You can return unordered or damaged goods to the vendor.  

  

Correcting PO Invoice Holds  

  

Sometimes invoices successfully matched to Purchase Orders go on hold and cannot be paid due to missing 

receiving. Following is the code you will see in the On Hold column (Purchase Order Summary>Enter PO 

number>Find>Inquire>View Invoices). 

  

QTY REC (Quantity Received)  

  

This hold occurs when system receiving has not been entered. Enter the receiver into the Integrated System in order for 

the invoice to be released and paid.  

  

  

  

Using Express Receiving 

If you have received all the goods requested on the purchase order, you can use the 
Express option to quickly process your receiving. This is especially helpful when you have a 

large purchase order with multiple lines.  

Procedure 

 
In this simulation you have received all items in a purchase order and want to use the express 

receiving feature. 
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Step Action 

1. From your Home page, navigate to the Find Expected Receipts screen. 

 

UVA PO Purchaser > Purchasing > Receiving, click the Receipts link. 
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Step Action 

2. The Find Expected Receipts screen displays. 

 

Choose the source type of Supplier. 

Click the Source Type list. 

 

3. Click the Supplier list item. 

 

4. To narrow your search, enter search criteria in other fields as desired, including 

Purchase Order number, Supplier name, and Receiving Location.  

 

You can use the ellipsis (...) in any field to select from the LOV. 

5. In this example, search by PO number. 

 

Press [Tab]. 

6. Enter the desired information into the Purchase Order field. Enter "1699301". 

7. Click the Find button. 

 

8. The Receipt Header screen displays. Enter receiving information in any of the 

following fields: 

• Packing Slip (optional) - Enter a packing slip name or number 

• Freight Carrier (optional) - Select from the LOV 

• Receipt Date - Defaults to the current date, which you can change 

• Shipped Date (mandatory) - Use the calendar to enter the date the goods or 

services were shipped 

9. This is where you enter the date that the goods or services were shipped from the 

vendor. 

 

Click in the Shipped Date field. 

 

10. Choose the date from the calendar. 

 

Click the Shipped Date... button. 

 

11. In this example the vendor shipped on April 1.  

 

Click the 1 button. 
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Step Action 

12. Click the OK button. 

 

13. Enter any other information as desired, including optional text in the Comments 

field.  

 

Next, click anywhere on the Receipt form (which opens behind the Receipt Header) 

to navigate to the appropriate receipt. 

 

14. The items listed in the PO display.  

 

Click the horizontal scrollbar. 

 

15. If blank, enter a delivery location code in the Location field (select from the LOV). 

 

If blank, enter a name in the Requester field. This required field is not free form and 

is case-sensitive. 

(1) Enter the last name, comma, and then the first initial of the first name. 

(2) Press [Tab]. The system validates the name you enter with the HR tables for 

each receiving line 

(3) Use [Shift] + F5 to copy the name to other lines if you are receiving against a 

multi-line PO. 

16. When you have finished reviewing/editing the fields, click the Express button. 

 

17. Important Note: Do not change the Destination Type. 

 

Click the OK button. 

 

18. If you selected the Express button and realize you did not receive all the goods, you 

can click the UnExpress button to undo express receiving.  

19. Save the express receiving. 

 

Click the Save button. 

 

20. A confirmation note displays. 

 

Click the OK button. 
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Step Action 

21. Click the Header button. 

 

22. The number now displays in the Receipt field. 

 

Document the receipt number on your packing slip. 

 

Important Note: You must ensure that receiving documentation has been signed 

and dated by the person who received the goods into the department. 

23. Congratulations, you have completed the simulation for express receiving. 

End of Procedure. 

Entering Receiving 

Sometimes you do not receive all items at once. Often, you will need to enter receiving for a 
single item at a time. 

Procedure 

 
In this simulation you receive a single item. Then you will see how to receive against a standing 

PO, for which you need to receive in a dollar amount. 
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Step Action 

1. From your Home page, navigate to the Find Expected Receipts screen. 

 

UVA PO Purchaser > Purchasing > Receiving, click the Receipts link. 

 

 

 
 

Step Action 

2. The Find Expected Receipts screen displays. 

 

Choose the source type of Supplier. 

Click the Source Type list. 
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Step Action 

3. Click the Supplier list item. 

 

4. To narrow your search, enter search criteria in other fields as desired, including 

Purchase Order number, Supplier name, and Receiving Location.  

 

You can use the ellipsis (...) in any field to select from the LOV. 

5. In this example, search by PO number. 

 

Press [Tab]. 

6. Enter the desired information into the Purchase Order field. Enter "1699299". 

7. Click the Find button. 

 

8. The Receipt Headers screen displays. Enter receiving information in any of the 

following fields: 

• Packing Slip (optional) - Enter a packing slip name or number 

• Freight Carrier (optional) - Select from the LOV 

• Receipt Date - Defaults to the current date, which you can change 

• Shipped Date (optional) - Use the calendar to enter the date the goods or services 

were shipped 

9. Click in the Shipped Date field. 
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Step Action 

10. Choose the date from the calendar. 

 

Click the Shipped Date ... button. 

 

11. In this example the ship date is March 28.  

 

Click the 28 button. 

 

12. Click the OK button. 

 

13. Enter any other information as desired, including optional text in the Comments 

field.  

 

Next, click anywhere on the Receipt form (which opens behind the Receipt Header) 

to navigate to the appropriate receipt. 

 

14. Check the box next to the goods/service you are receiving. 

 

Click the Select Line option. 

 

15. The quantity defaults from the PO. You can change the quantity by clicking in the 

Quantity field and adjusting the number. 

16. Click the horizontal scrollbar. 

 

17. If blank, enter a delivery location code in the Location field (select from the LOV). 

 

If blank, enter a name in the Requester field. This required field is not free form and 

is case-sensitive. 

(1) Enter the last name, comma, and then the first initial of the first name. 

(2) Press [Tab]. The system validates the name you enter with the HR tables for 

each receiving line 

(3) Use [Shift] + F5 to copy the name to other lines if you are receiving against a 

multi-line PO. 

18. When you have finished reviewing or editing all lines received, click 

the Save button. 

 

19. Click the Header button. 
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Step Action 

20. The number now displays in the Receipt field. 

 

Document the receipt number on your packing slip. 

 

Important Note: You must ensure that receiving documentation has been signed 

and dated by the person who received the goods into the department. 

21. In this next simulation, you wish to receive a dollar amount for services rendered. 

 

(You have already entered the mandatory Ship Date in the Receipt Header screen.) 

 

Click the Select line option. 

 

22. Click in the Quantity field. 

 

23. Enter the correct amount received. Enter "7600". 

24. After verifying the Location and Requester information, click the Save button. 

 

25. Return to the Receipt Header and document the Receipt number on your packing 

slip. 

 

(Also ensure that receiving documentation has been signed and dated by the person 

who received the goods into the department.) 

 

Click the Header button. 

 

26. Congratulations, you have completed the simulation for entering receiving. 

End of Procedure. 

Receiving Multiple Distributions 

Procedure 

 
In this simulation you will see how to receive against purchase orders that have multiple 

distribution lines.  
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Step Action 

1. From your Home page, navigate to the Find Expected Receipts screen. 

 

UVA PO Purchaser > Purchasing > Receiving, click the Receipts link. 
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Step Action 

2. The Find Expected Receipts screen displays. 

 

Choose the source type of Supplier. Click the Source Type list. 

 

3. Click the Supplier list item. 

 

4. To narrow your search, enter search criteria in other fields as desired, including 

Purchase Order number, Supplier name, and Receiving Location.  

 

You can use the ellipsis (...) in any field to select from the LOV. 

5. In this example, search by PO number. 

 

Press [Tab]. 

6. Enter the desired information into the Purchase Order field. Enter "1699309". 

7. Click the Find button. 

 

8. The Receipt Headers screen displays. Enter receiving information in any of the 

following fields: 

• Packing Slip (optional) - Enter a packing slip name or number 

• Freight Carrier (optional) - Select from the LOV 

• Receipt Date - Defaults to the current date, which you can change 

• Shipped Date (mandatory) - Use the calendar to enter the date the goods or 

services were shipped from the vendor 

9. Click in the Shipped Date field. 

 

10. Choose the date from the calendar. 

 

Click the Shipped Date ... button. 

 

11. In this example the vendor shipped on March 28. 

  

Click the 28 button. 

 

12. Click the OK button. 
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Step Action 

13. Enter any other information as desired, including optional text in the Comments 

field.  

 

Next, click anywhere on the Receipt form (which opens behind the Receipt Header) 

to navigate to the appropriate receipt. 

 

 

14. A blue + sign indicates there are multiple distributions for this PO line. Do not 

receive against this line. 

15. Expand the line to view the different PTAEOs for the PO line. 

 

Click the + sign. 

 

16. Review the multiple distributions and select the line(s) for the distribution(s) against 

which you are going to receive. 

 

In this simulation you will receive 1 package per each PTAEO line. 

 

Click the Select Line option. 

 

17. Click in the Quantity field. 

 

18. Enter the desired information into the Quantity field. Enter "1". 

19. Click the horizontal scrollbar. 

 

20. If blank, enter a delivery location code in the Location field (select from the LOV). 

 

If blank, enter a name in the Requester field. This required field is not free form and 

is case-sensitive. 

(1) Enter the last name, comma, and then the first initial of the first name. 

(2) Press [Tab]. The system validates the name you enter with the HR tables for 

each receiving line 

(3) Use [Shift] + F5 to copy the name to other lines if you are receiving against a 

multi-line PO. 

21. Click the Select Line option. 

 

22. Verify that the quantity equals the quantity received. 

 

Press [Enter]. 
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Step Action 

23. In this simulation, the location and requester are not displayed but are the same as 

the line above. 

 

Click in the Location field. 

 

24. Press [Shift+F5]. 

25. Press [Tab]. 

26. Press [Shift+F5]. 

27. When you have finished reviewing or editing all lines received, click 

the Save button. 

 

28. Click the Header button. 

 

29. The number now displays in the Receipt field. 

 

Document the receipt number on your packing slip. 

 

Important Note: You must ensure that receiving documentation has been signed 

and dated by the person who received the goods into the department. 

30. Congratulations, you have completed the simulation for receiving multiple 

distributions. 

End of Procedure. 

Reviewing a Receiving Transaction 

As needed, you can review your receiving transactions.  

Procedure 

 
In this simulation you want to review a recently received purchase order. 
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Step Action 

1. From your Home page, navigate to the Find Receiving Transactions screen. 

 

UVA PO Purchaser > Purchasing > Receiving, click the Receiving Transactions 

Summary link. 
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Step Action 

2. The Find Receiving Transactions screen displays. 

 

Choose the source type of Supplier. 

Click the Source Type list. 

 

3. Click the Supplier list item. 

 

4. To narrow your search, enter search criteria in other fields as desired, including 

Receipt number, Purchase Order number, Supplier name, and Receiving 

Location.  

 

You can use the ellipsis (...) in any field to select from the LOV. 

5. In this example, search by PO number. 

 

Press [Tab]. 

6. Enter the desired information into the Purchase Order field. Enter "1085154". 
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Step Action 

7. Click the Find button. 

 

8. The Receipt Headers Summary screen displays. If your search generated more 

than one transaction, place the current record indicator (blue box) next to the receipt 

you want to view. 
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Step Action 

9. Click the Transactions button. 

 

10. The Receipt Transaction Summary form displays. Scroll to view all information. 

 

Click the horizontal scrollbar. 

 

11. Click the horizontal scrollbar. 

 

12. Congratulations, you have completed the simulation for reviewing a receiving 

transaction. 

End of Procedure. 

Returning an Item 

Use these instructions to return items against POs (for goods or services $5,000 and greater) 
that do not tie back to an iProcurement requisition (e.g., line added by a Procurement 
Services Buyer) or that were created prior to the Marketplace (prior to 12/4/2006).   
 
Note: You may enter receiving in iProcurement (Receiving tab - Receive items) for POs 
created in the Marketplace. Review the iProcurement and the UVa Marketplace training guide 
for instructions on how to receive in iProcurement. 

Procedure 

 
In this simulation you will return a damaged item. 
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Step Action 

1. From your Home page, navigate to the Find Returns screen. 

 

UVA PO Purchaser > Purchasing > Receiving, click the Returns link. 

 

2. The Find Returns screen displays. 

• If not the default value, change the Source Type to Supplier. 

• To narrow your search, enter search criteria in other fields as desired, including 

Receipt number, Purchase Order number, Supplier name, and Current Location.  

• You can use the ellipsis (...) in any field to select from the LOV. 
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Step Action 

3. In this example, search by PO number. 

 

Click in the Purchase Order field. 

 

4. Enter the desired information into the Purchase Order field. Enter "1074194". 

5. Click the Find button. 

 

6. The Receiving Returns screen displays.  

 

If your search generated more than one transaction, place the current record 

indicator (blue box) next to the receipt you want to return. 

7. Note the information (red arrow), including description, that displays for each line 

item.  

 

Check the box next to the goods/service you are returning.   

 

For this example, you will be returning the first line item. 

  

Click the Line Selection option. 

 

8. Enter the quantity to return. 

 

Press [Tab]. 
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Step Action 

9. Enter the desired information into the Quantity field. Enter "1". 

10. Tab to the Return To field. 

 

Press [Tab]. 

11. Press [Tab]. 

12. Select Supplier from the list of values. 

 

Click the Return To button. 

 

13. If Supplier is the default value, click the OK button. 

 

14. The supplier's name automatically displays in the Supplier/Customer/Location 

field. 

 

If the vendor supplies a Returned Materials Authorization (RMA) number or other 

reference number for the return, enter it in the RMA Number field. 

15. After processing all returns on this PO, save your work. 

 

Click the Save button. 

 

16. After entering your return, you can view the receipts history in the Receipt 

Transaction Summary page. (For further instruction see the Reviewing a 

Receiving Transaction topic).  

17. Congratulations, you have completed the simulation for returning an item. 

End of Procedure. 

Correcting a Receipt in the Integrated System 

Use these instructions to correct receiving against POs (for goods or services $5,000 and 
greater) that do not tie back to an iProcurement requisition (e.g., line added by a 

Procurement Services Buyer) or that were created prior to the Marketplace (prior to 

12/4/2006).     
  
Note: You may correct receiving in iProcurement (Receiving tab - Receive items) for POs created in the 
Marketplace. Use this link (http://www.procurement.virginia.edu/o/uvamarketplacetraining.pdf) to access 

the Marketplace training guide for instructions on how to receive in iProcurement.  
  
Since "Receiving" performs two actions ("Deliver" and "Receive"), corrections require two actions. You 

must save and close the form in between the two actions.  

Procedure 

 
In this simulation you entered an amount in error so you need to correct it.  

http://www.procurement.virginia.edu/o/uvamarketplacetraining.pdf
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Step Action 

1. From your Home page, navigate to the Find Corrections screen. 

 

UVA PO Purchaser > Purchasing > Receiving, click the Corrections link. 
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Step Action 

2. The Find Expected Receipts screen displays. 

 

Choose the source type of Supplier. 

Click the Source Type list. 

 

3. Click the Supplier list item. 

 

4. To narrow your search, enter search criteria in other fields as desired, including 

Receipt number, Purchase Order number, Supplier name, and Current Location.  

 

You can use the ellipsis (...) in any field to select from the LOV. 

5. In this example, search by PO number. 

 

Click in the Purchase Order field. 

 

6. Enter the desired information into the Purchase Order field. Enter "1084558". 

7. Click the Find button. 

 

8. The Receiving Corrections screen displays.  

 

If your search generated more than one transaction, place the current record 

indicator (blue box) next to the Deliver line of the item you want to correct. 

 

Note the information (red arrow), including description, that displays. 

9. Step 1: Correct the "Deliver" Transaction Type 

 

Check the box next to the Deliver row you are correcting. 

 

Click the Line Selection option. 

 

10. Enter the quantity to correct. 

 

Press [Tab]. 

11. Enter the positive or negative correction quantity. 

 

Enter the desired information into the Quantity field. Enter "-7600". 
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Step Action 

12. Save your work. 

 

Click the Save button. 
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Step Action 

13. Step 2: Correct the "Receive" Transaction Type 

 

Step one is complete. You must navigate to the Receiving Corrections form again 

to complete correction to the "Receive" transaction. 

 

Click the Close button. 

 

14. Double-click the Purchasing list item. 

 

15. Double-click the Receiving list item. 

 

16. Double-click the Corrections list item. 

 

17. Click the Source Type list. 

 

18. Click the Supplier list item. 

 

19. Click in the Purchase Order field. 

 

20. Enter the desired information into the Purchase Order field. Enter "1084558". 

21. Click the Find button. 

 

22. Check the box next to the Receive row you are correcting. 

 

Click the Line Selection option. 

 

23. Press [Tab]. 

24. Enter the same correction as you did on the Deliver Transaction Type line. 

 

Enter the desired information into the Quantity field. Enter "-7600". 

25. Click the Save button. 

 

26. After entering your return, you can view the receipts history in the Receiving 

Transaction Summary page. (For further instruction see the Reviewing a 

Receiving Transaction topic). 
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Step Action 

27. Congratulations, you have completed the simulation for correcting a receipt. 

End of Procedure. 

Working with the PTAO Card Generator 

The PTAO Card Generator creates a bar code for the PTAO you enter.  You can print out the PTAO bar 

code and use it to purchase items from internal service providers. Examples of spending include postage 

(mailroom), and purchasing items from the UVA Bookstore and Cavalier Computers.  It can also be is used 

to verify that the PTAO is valid for spending. 

In order to use the PTAO Card Generator, you must have access to NetBadge and Employee Self-Service 

within the Integrated System. 

The PTAO Card Generator icon is located on the Integrated System home page and looks like this: 

  

 

Validating a PTAO using the PTAO Card Generator 

Procedure 

 
In this simulation you will see how to use the PTAO Card Generator to validate a PTAO. 
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Step Action 

1. Click the PTAO Card Generator button. 
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Step Action 

2. You will need to log in to NetBadge.  If your computer has the digital certificate 

downloaded, you can click the Log In button.   

 

If you are on a public computer or your computer does not have the digital 

certificate downloaded, you will need to log in with your UVA computing ID and 

your password.   

 

Type the desired information into the UVa computing ID box. Type "tj1va". 

 

3. After entering your password, you can log in.  

 

Click the Log In button. 

 

 

 
 

Step Action 

4. The University of Virginia PTAO Card Generator page displays. 

 

Note the information at the top of the page. 

 

Press ENTER. 
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Step Action 

5. Let's practice validating a PTAO.   

 

Enter a Project number. 

Type "147895". 

 

6. Press TAB. 

 

 
 

Step Action 

7. Search for the associated Task number(s) from the list of values. 
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Step Action 

8. There are three Tasks associated with this project. Select the appropriate Task 

number. 

 

Click the PTA1O-pta1o link. 
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Step Action 

9. Search for the associated Award or manually enter the award information. 

 

When manually entering PTAO information, the Award Number is case sensitive 

(use upper case).  

 

Click the List of Values: Award button. 

 

 

 
 

Step Action 

10. Click the DR12345  link. 
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Step Action 

11. Enter the appropriate Organization code.  

 

Type the desired information into the Organization box. Type "20030". 

 

12. Click the Submit button. 

 

13. The PTAO Card Generator validated the information you entered and created a 

Barcode.  

 

Note: For those individuals with a purchasing responsibility, you may print this 

page. 

14. Congratulations! You have successfully validated a PTAO using the PTAO Card 

Generator. 

End of Procedure. 

Working with Payment Vouchers 

  

Payment Voucher Overview   

  

Appropriate Uses of the Payment Voucher 
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Check the Goods & Services Procurement Guide (http:www.procurement.virginia.edu/pageprocguidev2) on the 

Procurement website to see what commodities are allowed on a Payment Voucher as the policies can sometimes 

change. 

  

A Payment Voucher may be used for processing payments for the following items: 

• eVA-excluded items 

• Payments to individuals for research participation 

• Travel for official University travel, as documented on a travel workbook 

• Reimbursements to petty cash custodians, as documented on a petty cash workbook 

Some high-risk transactions automatically go on "HOLD" and require Procurement to release them. 

  

Paper Documentation Required 

 

There are two types of Payment Vouchers that require original paper documentation. 

  

• Travel Reimbursement:  The original Travel Workbook and all supporting 
documentation must be submitted to Procurement. 

• Petty Cash Reimbursement:  The original Petty Cash reimbursement form and all 
supporting documentation must be submitted to Procurement.  The completed UVA 
Payment Voucher must be used as a cover sheet. 

The supporting documentation must be completed and approved prior to sending the paper documentation to 

Procurement.  The department originating the Payment Voucher will maintain the documentation for all other types of 

Payment Vouchers. 

  

  

Reimbursing Travel: 

The Payment Voucher form is used to reimburse costs incurred while on business travel.   

  

Before completing and submitting a payment voucher in the IS, employees must complete the Travel Workbook, which 

can be found on the Procurement and Supplier Diversity Services website. 

  

http://www.procurement.virginia.edu/pagetravelformlist 

  

Once the Travel Workbook has all the required signatures and supporting documentation (receipts), enter the payment 

voucher into the IS. The paper version of the Travel Workbook is sent to Procurement (Accounts Payable) for their 

review.   

  

You have the option to electronically attach the Travel Workbook to the payment voucher using the attachment 

(paperclip) icon. However, Accounts Payable will audit only the original paper documentation with receipts. 
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Reimbursing Petty Cash: 

Departments may have either cash or checking petty cash accounts. Not every department uses petty cash. The 

university is not opening any new accounts.   

  

The Petty Cash custodian will prepare a Petty Cash Reimbursement form and submit it to the PO Purchaser 

for entering a payment voucher into the IS. 

  

The PO Purchaser: 

• Prepares a Payment Voucher to reimburse the Custodian. All petty cash custodians must be listed in the IS 

vendor file in order to receive payment. Custodians are added at the time the petty cash account is 

established. For example, they will be listed in the vendor file as "Custodian Webster, Donna".  

  

• Runs and prints a Payment Voucher/Invoice Report (used as the cover sheet) to be sent to 

Procurement with all original receipts keeping a copy of everything for their records. 

  

Reimbursing Students: 

  

Students are not required to use their taxpayer ID number (TIN) or social security number (SSN) when registering at 

the University as a Student.  However, if a Student is paid for services that may be considered taxable income and 

results in the issuance of a 1099, a valid TIN must be supplied.  

• This includes all Services Expenditure Type categories as well as:  
o Human Subject payments, 
o Cash Awards and Prizes, 
o Honoraria, 
o any other taxable expenditure types. 

The department should verify that the only Supplier record in the Integrated System is the Student (SIS) record. The 

department can inform the student that they must complete a vendor registration form for individuals found on the 

Procurement & Supplier Diversity Services' (PSDS) website at 

www.procurement.virginia.edu/pagevendorregistrationform 
(https://www.procurement.virginia.edu/pagevendorregistrationform)  or they can have the 

student add their SSN in SIS so it will automatically feed to the vendor file.   

  

Note: Payment Vouchers for services that reference an invalid TIN (SSN) number will be placed on HOLD until a 

valid number is supplied. The preparer will be notified by PSDS.  

  

  

Upon completion of this module, you will be able to:  

• Manage payment vouchers; including viewing, adding, editing, canceling, and deleting them 

https://www.procurement.virginia.edu/pagevendorregistrationform
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To start a simulation:  

  

1.  Double-click on the module.  

  

2.  Double-click on the section.  

  

3.  Click on the topic you wish to view.      

  

4.  Click "Try It" in the upper right-hand corner to interact with the simulation. Click "Print It" 
to print out a Job Aid.   

Entering Payment Voucher Information on the General Tab 
  

Procedure 

 
In this simulation you will begin by entering information on the General tab when creating a 

payment voucher. 
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Step Action 

1. Begin by navigating to the Payment Voucher form.   

 

Click on the Payment Voucher link to access the form. 

 

2. The Payment Voucher displays. 

 

You may use the predefined yellow folder (Payment Voucher R12) to rearrange 

the fields, but it is not required. 

 

The Type field defaults to Standard. Do NOT change it! 

3. The Trading Partner is the supplier/vendor, employee, or student you are paying.   

 

This is the name that will appear on the check. 

 

 
 

Step Action 

4. Click in the Trading Partner field.   

 

5. Click on the drop down list of values (LOV) to search for the Trading Partner. 

 

This list is the UVA Vendor file of those who can receive a payment.  
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Step Action 

6. Enter the Trading Partner name in the Find field.   

 

Note:  You can use the percentage (%) sign to narrow your search. 

 

For this example, you are searching for Journal of Bone & Joint Surgery. 

 

Enter the desired information into the Find field. Enter "journal of %". 

7. Click on the Find button. 

 

8. Choose from the resulting list. 

 

Click on Journal of Bone & Joint Surg. 

 

9. Click the OK button. 

 

10. The Supplier Number defaults when you select the Supplier/Trading Partner.   

 

It is the number generated by the system when the Supplier/Trading Partner is first 

entered into the system. 

11. The Supplier Site is the address information for the Supplier/Trading Partner. 

 

Click in the Supplier Site field. 

 

Note:  If there is only one site, it will default.  Otherwise, choose the site from the 

LOV. 

 

12. Click in the Invoice Date field. 

 

13. Click on the drop down LOV to access the calendar and select the date printed on 

the invoice. 
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Step Action 

14. In this example, the calendar displays for April. Select April 4th from the calendar. 

 

Click on 4. 

 

15. Click the OK button. 

 

16. The information entered in the Invoice Num and Description fields appears on the 

check stub or the Direct Deposit notification.   

 

This helps the payee identify the payment. 
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Step Action 

17. Click in the Invoice Num field. 
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Step Action 

18. The Invoice Num field is a free-form field.     

 

Enter the invoice number from the invoice. This number cannot be a duplicate.   

 

If this is a payment for an employee or a student and there is no invoice number, 

enter your email address prefix, followed by the current date (e.g., JSJ6B 7-APR-

2016). 

 

Note:  Always use upper case when entering verbiage. 

 

Enter "221" into the Invoice Num field. 

 

 
 

Step Action 

19. Enter the amount from the invoice into the Invoice Amount field.  

 

Enter "100.00" into the Invoice Amount field. 

20. Click in the Description field. 

 

21. The Description field appears on the check stub or the Direct Deposit notification to 

help the payee identify the payment. 

 

Enter "one year Dr McQ" into the Description field. 
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Step Action 

22. To access other fields on the form, click the horizontal scrollbar. 

 

 

23. Depending on the Trading Partner selected, the value in the Terms field defaults 

from the Vendor File.   

• Net 30 days defaults as the standard for most Trading Partners, suppliers, or 

vendors unless different terms have been negotiated with the Trading Partner. 

• Faculty, staff, and students terms default to Immediate.  

 

You are allowed to change the terms to Immediate when paying the following: 

- Human Subjects 

- Honoraria 

- Travel (non-employees) 

24. Click in the Date Invoice Received field. 

 

25. Click the drop down LOV to access the calendar. 
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Step Action 

26. The calendar displays with the current date selected.   

 

For this example, use the date shown as current (April 7). 

 

Click the OK button. 

 

 

 
 

Step Action 

27. Click in the Date Goods Received field. 

 

 

28. Click the drop down LOV to access the calendar. 
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Step Action 

29. For this example, the subscription begins on May 1. The calendar displays April and 

the first week of May.   

 

Click on 1 to select May 1, 2016. 

 

30. Click the OK button. 
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Step Action 

31. When you select a future date, the system generates a Caution note. 

 

Click the OK button to close the message. 

 

 

 



Training Guide 

 
 

 

 Page 290 

 

Step Action 

32. Click the Save button. 

 

33. The system automatically generates a note that includes the payment voucher 

number.   

 

Important: Record the voucher number (In this example, 3311259) on the invoice.  

 

Click the OK button.   

 

34. Congratulations! You have successfully completed the simulation for entering 

information on the General tab when creating a payment voucher.  

 

The next topic shows you how to access the Lines tab and enter the PTAEO 

information. 

End of Procedure. 

Entering PTAEO Information on the Lines Tab 

Once the payment voucher General tab is completed and saved, and the system has 
generated a Payment Voucher Number, access the Lines tab to enter the PTAEO 
information for the payment voucher.   

 
  

Procedure 

 
In this simulation you will access the Lines tab and the Distributions page to enter the PTAEO 

information.   
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Step Action 

1. Click the 2 Lines tab.  
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Step Action 

2. Enter "100.00" into the Amount field.  

3. Enter the PTAEO information. 

 

Click the Distributions button. 

 

 

4. Note:  You may use the predefined yellow folder (Payment Voucher R12) to 

rearrange the fields for easier data entry. 

 

Do not enter information into the Account field! 

5. Notice there are many blank distribution lines available for you to use if you plan to 

split the payment voucher between several different PTAEOs.   

 

 
 

Step Action 

6. Enter "100.00" into the Amount field.  

7. Use your departmental PTAEO(s) when creating payment vouchers for your 

department. 

 

For this example, enter "101902" into the Project field.  

8. For this example, enter "101" into the Task field.  

9. Enter "sg00026" into the Award Number field.  
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Step Action 

10. Click on the Expenditure Type drop down LOV to see a list of expenditure types. 

 

11. You can use the Find field to search for an expenditure type. 

 

Click in the Find field. 

12. For this example, you are searching for Professional Licenses & Fees. 

 

Enter "profess%" into the Find field.  

13. Click the Find button.   

 

14. Notice that Professional Licenses & Fees defaulted because the LOV contained 

only one word beginning with "profess".   

15. Enter "20030" into the Expenditure Organization field.  

16. The Expenditure Item Date automatically defaults from the Invoice Date field. 

17. Save your work. 

 

Click the Save button. 

 

18. Close the window. 

 

Click the X button. 

 

19. Congratulations! You have successfully completed the simulation for accessing the 

Lines tab and the Distributions page to enter PTAEO information. 

 

In the next topic you will see how to use the Discard Line 1 button to create a 

reversal line if you entered an incorrect PTAEO.   

End of Procedure. 

Using the Discard Line1 Button 

The Discard Line1 button creates a reversal line for each previously entered PTAEO.   

  
You will use the Discard Line 1 button to correct the PTAEO information which you had 
previously entered and saved, but later determined was incorrect.   
  
Note:  The system will not let you change PTAEO information once it has been saved!  

Procedure 

 
In this simulation you will use the Discard Line1 button to reverse incorrect PTAEO information 

entered on a payment voucher.   
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Step Action 

1. Begin by clicking on the 2 Lines tab. 

 

2. Important Note: When you select this button, the system creates a reversal for 

EVERY distribution line entered.   

 

Click on the Discard Line 1 button.   

 

 

3. The line amount is now zero (0.00).   

4. View the new distribution lines. 

 

Click the Distributions button.  

 

5. The Line Total and Distribution Total fields show zero. 

 

A new line was automatically created to offset each line previously entered. 
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Step Action 

6. Click the Close button. 

 

7. The Discard Line1 and Distributions buttons are inactive (grayed out) for the Num 

1 line. 

 

Next, you will see how to enter a new line and distribution for the Payment 

Voucher. 
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Step Action 

8. You will re-enter the dollar amount and the new distribution (PTAEO) line(s) on the 

next available line.   

 

Notice both the Discard Line 2 and Distributions buttons are now active. 

 

Click in the Amount field for line 2. 

 

 

 

9. Notice the Discard button is now named Discard Line 2. 

 

Enter "100.00" into the Amount field.  

10. Click the Distributions button. 

 

11. Notice the Line and Distribution Totals do not agree. 
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Step Action 

12. Click in the Amount field. 

 

13. Notice the Line Number is 2. 

 

Enter "100.00" into the Amount field.  

14. Click in the Project field. 

 

15. Notice the Line and Distribution Totals agree and are no longer red. 

 

Enter the PTAEO. 

 

Enter "129924" into the Project field.  

16. Scroll to access other fields. 

 

Click the horizontal scrollbar. 

17. Enter "101" into the Task field.  

18. Enter "LS00347" into the Award Number field.  

19. Click in the Expenditure Type field. 

 

20. You can use the Find feature to locate an expenditure type. 

 

Click in the Find field. 
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Step Action 

21. Enter "Profess%" into the Find field.  

22. Click the Find button. 

 

23. The Expenditure Type field populated with one choice based on your search in the 

LOV. 

24. Enter "20030" into the Expenditure Organization field. 

25. Save your work. 

 

Click the Save button. 

 

26. Click the Close button. 

 

 

 
 

Step Action 

27. Click on the 1 General tab to view all distributions. 

 

28. Click the All Distributions button to view the newly added distribution line. 
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Step Action 

29. The Distributions page displays. 

 

 
 

Step Action 

30. Note:  Whenever you change a payment voucher, remember to approve and submit 

it to Accounts Payable. Refer to the Approving Payment Vouchers topic for more 

information. 

 

Click the Close button. 

 

31. Congratulations! You have successfully completed the simulation for using the 

Discard Line1 button to reverse incorrect PTAEO information entered on a 

payment voucher.   

End of Procedure. 

Adding an Attachment to a Payment Voucher 

Procedure 

 
In this simulation you will add an attachment to a payment voucher. 
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Step Action 

1. Note:  Always add attachments on the General Tab so they are visible to others. 

 

Click the Attachments link. 
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Step Action 

2. Click in the Category field. 

 

3. Category must be Miscellaneous. You can use a shortcut for entering the value. 

 

Enter "m" into the Category field and [Tab] to the next field. 

4. You must enter text in either the Title and/or Description fields. 

 

Title is an optional free form field. It allows you to name the attachment.   

 

Enter "JB&JS Order Form" into the Title field and [Tab] to the next field.  

5. Description is a free form field used to explain what the payment is for. 

 

Enter a Description and [Tab] to the next field. 

 

Enter the desired information into the Description field. Enter "JB&JS Order 

Form". 

6. Click on the Data Type LOV. 

 

7. Choose from the list of options. File (Excel or Word document) is the default. Use 

this type in the example. 

 

Other Data Types are: 

- Long Text: A note up to 4,000 characters in length 

- Short Text: A note up to 2,000 characters in length 

- Web Page: Allows you to attach a web page 

 

Click the OK button. 
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Step Action 

8. Search for the file you wish to attach.  

  

Note: This opens in a separate screen and may open in the background. 

 

Click the Browse button. 
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Step Action 

9. Find the file you wish to attach. 

 

Double click on the file named "JB&JS.pdf". 
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Step Action 

10. Click the Submit button. 

 

 

 
 

Step Action 

11. Notice the Confirmation message with instructions. 

 

Click on the Close button. 
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Step Action 

12. A message asks if the file was uploaded successfully. 

 

Click the Yes button. 

 

13. Click the Open Document... button to verify the correct file is attached.  
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Step Action 

14. The attachment named "JB & JS Order Form displays. 

 

Click the Close button. 
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Step Action 

15. Save your work. 

 

Click the Save button. 

 

16. Click the Close button. 

 

17. Notice that the attachment link does not yet show a yellow paper under the 

paperclip, which indicates when an attachment is present.   

 

There are several ways to refresh the screen to see the attachment.  

18. One way to refresh the attachment link is to click first on the Lines tab, then click 

back on the General tab.  

19. Notice the yellow paper is now visible under the paper clip. 

20. Congratulations!  You have successfully completed the simulation for adding an 

attachment to a payment voucher. 

End of Procedure. 

Approving Payment Vouchers 

Procedure 

 
In this simulation you will approve and submit a payment voucher. 
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Step Action 

1. Click the Actions... 1 button. 

 

2. The Payment Voucher Actions page displays. 

 

There are many actions to choose from.    

 

Next you will see a description for each of them. 

 

 
 

Step Action 

3. This page describes each payment voucher action.   

 

Note: The most important action button is All Approvals Have Been 

Obtained. You must select it each time you request a payment! 

 

You may select multiple buttons at once. 
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Step Action 

4. In this example, click on the All Approvals Have Been Obtained checkbox. 

 

5. Click the OK button. 

 

6. The Status of the payment voucher will be one of the following: 

  

- Never Validated: The All Approvals Have Been Obtained button has not been 

selected. The payment voucher will not be reviewed or approved by Procurement.  

     

- Needs Revalidation: The Payment Voucher requires final approval by Accounts 

Payable (all Travel & Petty Cash).  

 

- Validated: The payment will be scheduled after AP reviews the voucher.  

 

- Cancelled: The payment voucher has been cancelled. Look for additional 

information via the attachment (paper clip) icon. 

7. Congratulations!  You have successfully completed the simulation for approving and 

submitting a payment voucher. 

End of Procedure. 

Running and Printing the Payment Voucher/Invoice Report 

Procedure 
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You may need to print the payment vouchers you created. 

 

In this simulation, you will learn how to run and print the Payment Voucher/Invoice Report. 

 
 

Step Action 

1. Expand the Reports link to find the report. 

 

Click on the Run link. 
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Step Action 

2. The Submit a New Request page displays.  It automatically defaults to "Single 

Request". 

 

Click on the OK button. 
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Step Action 

3. Click on the drop down LOV for the Name field. 

 

 

 
 

Step Action 

4. Click the UVA Payment Voucher/Invoice Report. 
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Step Action 

5. Click the OK button. 

 

6. Enter parameters for your request.   

 

If you are printing a single payment voucher, enter the payment voucher number in 

the "Voucher Number From" and TAB.   

 

If you are running a report for multiple payment vouchers, enter a Voucher 

Preparer ID (user ID) AND a range of voucher numbers using the "Voucher 

Number From" and "Voucher Number To" fields. 

 

For this example, you will run a report for a single payment voucher. 

7. Click in the Voucher Preparer ID field. 

8. Enter your user ID into the Voucher Preparer ID field.  

 

Enter "JSJ6B". 

9. Click in the Voucher Number From field. 

 

10. Enter the payment voucher number you created into the Voucher Number 

From field.  

 

Enter "3311259". 
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Step Action 

11. Click on the OK button. 

 

12. Click on the Submit button. 

 

13. There are many phases when submitting a request ID to print. 

 

This request ID is in a "Pending" phase. 

 

As you continue to click on the Refresh Data button, it will move to "Running" 

and finally "Completed".  

 

 
 

Step Action 

14. Click on the Refresh Data button. 

 

15. Click on the Refresh Data button. 
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Step Action 

16. Notice the phase is now "Completed". 

 

Note: You must have Adobe Reader software that is compatible with your 

Windows version.  Contact your Local Support Partner (LSP) for assistance. 

 

Click on the View Output button. 

 

17. This is the output for payment voucher number 3311259. 

 

18. You may print the Payment Voucher/Invoice report by selecting File>Print. 

 

Another way to print the report would be to click on the printer icon on the browser 

toolbar.   

 

This report should be printed in landscape orientation. 

19. Congratulations!  You have completed the simulation on how to run and print the 

Payment Voucher/Invoice Report. 

End of Procedure. 

Finding and Reviewing a Payment Voucher 

You can find and review your payment vouchers using the Flashlight icon or by running a 
query on the voucher number. If you cannot recall the voucher number, you can query on 

the Trading Partner/Supplier name and the invoice number to find the payment voucher.  
  

Once the payment voucher has been approved, it is available for Accounts Payable 
(Procurement) to process the payment. If no changes are required, payment will be made.  

Procedure 

 
This simulation shows two different methods of finding payment vouchers. 
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Step Action 

1. Begin by navigating to the Payment Voucher form.   

 

Click on the Payment Voucher link to access the form. 

 

2. Method 1: Using the Flashlight icon. 

 

Click the Flashlight icon. 

 

3. The Find Invoices screen displays. 

 

You can search by Trading Partner/Supplier, Invoice Number or Voucher 

Number, or a combination of the three. 
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Step Action 

4. In this example, search for a payment voucher using the invoice number and 

voucher number. 

  

Click in the Invoice Number field. 

 

5. Enter the desired information into the Invoice: Number field. Enter "221". 

6. Click in the Voucher Audit Numbers: Start field. 

 

7. Enter the desired information into the Voucher Audit: Numbers: Start field. Enter 

"3311259". 

8. Press [Tab]. 

9. The voucher number automatically populates the Voucher Audit Numbers: 

End field. 

 

Click the Find button. 

 

10. The Payment Voucher displays. 

 

As needed, you can use the All Distributions button to review the distributions. 
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Step Action 

11. Method 2: Run a Query 

 

From the menu bar, select View>Query by Example>Enter.  

 

Click the Enter menu. 

 

12. Click in the Invoice Num field. 

 

13. Enter the desired information into the Invoice Num field. Enter "221". 

14. From the menu bar, select View>Query by Example>Run. 

 

 

Click the Run menu. 

 

15. The Payment Voucher displays. 

 

As needed, you can use the All Distributions button to review the distributions. 

16. Congratulations! You have completed the simulation for using two different 

methods to find payment vouchers. 

End of Procedure. 
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Viewing the Status of a Payment Voucher 

You may view the status of your payment voucher to determine whether it has been paid, 
the payment date, check number, etc.  
  
The Invoice Overview screen shows information about the payment voucher including:  

• status 

• current hold and reason, if any 

• scheduled due date 

  
Accessing Payment Overview  
  

If the payment voucher is paid, the check number, date, and amount paid is also shown on 
the Invoice Overview screen.  
  
You can click on the check number to activate the Payment Overview button.  
  
On the Payment Overview screen, you can see the address the check was sent to, the 

payee's name, and a list of invoices that were paid by the check. This information displays 
on the check stub that is received by the Trading Partner (Supplier).   
  
The status of the check, cashed or negotiable (not yet cashed) is also shown.  
  
  
  

  

Procedure 

 
In this simulation you will view a payment voucher to see information, including payment status 

and check number. 
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Step Action 

1. You will need to go to the Invoice Overview. 

 

UVA Purchaser >> Accounts Payable >> Invoices >> Inquiry >> Invoice Overview 

 

Click Invoice Overview 

 

 

 
 

Step Action 

2. The Find Invoices page displays. You can enter search criteria such as Trading 

Partner, Invoice Number, and/or Voucher number. 

 

For this example, search by the voucher number. 

 

Click in the Voucher Start Number field. 

 

3. Enter the desired information into the Voucher Start Number field. 

Enter "3205210". 

4. Press [Tab]. 



 

Training Guide 
 

 

 Page 321 

Step Action 

5. The voucher number does not carry forward from the previous field.   

 

Enter the desired information into the Voucher End Number field. Enter 

"3205210". 

6. Click the Find button. 

 

7. The Invoice Overview page displays. 

 

Review the Invoice Status section. In this example, the payment status is Fully 

Paid.   

8. In this example the payment voucher is not on hold - the Active Hold and Reason 

sections are blank. It will be available for payment processing after Accounts 

Payable has reviewed it. 

 

If a hold is listed here, the payment cannot be made until Accounts Payable releases 

the hold. 

9. The Scheduled Payments and Actual Payments sections show payment details. 

 

Note the Paid By field. The check number and payment date is displayed here. 
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Step Action 

10. You can view more payment details. 

 

Click the Payment Overview button. 

 

11. The Payment Overview page displays. 

 

The payment in this example has a status of Negotiable. There is no date in the 

Cleared Date field, indicating that the payee has not yet cashed the check.  

12. The Invoices section populates with the invoice number and description entered on 

the payment voucher.    

13. From this page, you can return to the Invoice Overview page or access Payments. 

 

Bank and Supplier information is unavailable for review. 

 

 
 

Step Action 

14. Click the Close button. 

 

15. Congratulations! You have completed the simulation for viewing the status of a 

payment voucher. 

End of Procedure. 
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Deleting a Payment Voucher 

You can delete a payment voucher if you have entered and saved it (including 
distributions) but have not validated (approved) it - the status of the payment voucher is 
Never Validated.  
  
Once you validate a payment voucher, you cannot delete it.   
  

Deleting a payment voucher permanently removes it from the system.   

Procedure 

 
In this simulation you will delete a payment voucher that has been entered and saved but not 

validated (approved). 

 
 

Step Action 

1. First, search for the payment voucher to be deleted by clicking the Flashlight icon. 

 

Another method is to select View>Find from the menu bar. 
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Step Action 

2. The Find Invoices screen displays. 

 

To search by voucher number, click in the Voucher Audit: Numbers: Start field. 

 

3. Enter the desired information into the Voucher Audit: Numbers: Start field. 

Enter "2367356". 

4. Press [Tab]. 

5. The voucher number automatically populates the Voucher Audit: Numbers: 

End field. 

 

Click the Find button. 

 

6. Verify the payment voucher displayed is the one to be deleted and that the status is 

Never Validated. 
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Step Action 

7. To delete the payment voucher, click the red X icon. 

Click the Delete button. 

 

8. A caution message displays. This action cannot be undone. 

 

Click the OK button. 

 

9. To finalize deletion of the payment voucher, click the Save button. 

 

10. Congratulations! You have completed the simulation for deleting a payment 

voucher.   

End of Procedure. 

Changing and Resubmitting a Payment Voucher 

There may be situations where you need to change a validated payment voucher. You must 
make these changes shortly after submission:  
  

• Faculty, Staff and Students payment terms are set for "Immediate". Therefore, any 
changes to payments reimbursing these groups must be done the same day the 

payment voucher is submitted into the system.    

• Trading Partner/Suppliers Terms are set most often to "Net 30 days". Therefore, any 
changes to payments for these groups have a window of approximately 10 working 
days before the payment is processed by Accounts Payable.  
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No changes are allowed if the payment voucher has been paid.   
  
Check the status of the payment voucher to determine if it has been paid BEFORE you 
attempt to change it:  

• To verify that the invoice has not been paid, use Invoice Overview. Navigate to 
Accounts Payable: Invoices: Inquiry>Invoice Overview to determine the status of 
the payment voucher.   

  
If the payment voucher has been paid and the PTAEO information is incorrect, someone 
must process a GA Transaction (Cost Transfer) to make the correction. 
  
The following fields may be changed on a validated (approved) but not yet paid payment 
voucher:  

• Distributions (PTAEO) 

• Dollar Amount 

  
Rejection of Payment Vouchers 
If Procurement rejects your payment voucher, you will receive an email notification with 
the invoice number and vendor name of the rejected payment voucher. Procurement will 

document the reason(s) for rejecting the payment voucher by using the attachment 
(paperclip) functionality in the IS system.  
  
If you want to correct the problem with the payment voucher, you may do so and resubmit 
it to Procurement (Accounts Payable).  
  

Correcting Payment Voucher Holds  

The following are holds that require user correction:  
  
Voucher Returned to Dept: This hold indicates Procurement Services requires additional 
information before the transaction can be processed. You can use the paperclip to see what 
information is required. This alerts Procurement Services that the department has supplied 
the required information.  

  
Petty Cash Hold: This hold indicates the original documentation has not been received or 
reviewed by Procurement. Please ensure this paperwork is complete and forwarded to 
Procurement.  
  
Requires an Attachment: This hold indicates you requested original documentation to be 
mailed with the check, however the paperwork has not been received by Procurement. 

Payment cannot be processed until this paperwork is received.  
  
Restricted Item: This system hold is caused when a user selects a high-risk expenditure 

type. It requires Procurement to release this hold after review. It often indicates the 
original travel workbook has not been received or reviewed by Procurement. You must 
submit any required paperwork to Procurement as soon as possible.  

  
Dept. Hold: This hold is put on the transaction per the department’s request. Please 
resolve this issue and alert Procurement to remove the hold by using the 
Invoice/Correction Action form on Procurement’s website. Examples of resolution would be 
to contact the vendor and request the vendor to resend the bill after the issue is resolved. 
You can also partially pay an invoice but be sure the vendor is aware they need to send an 
invoice for the additional amount at a later time.  
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Awaiting Credit Memo: Contact the vendor and ask them to send a credit memo so this 
hold can be released. You do have the option to partially pay an invoice but be sure to alert 
the vendor so they can correct their records.  

  
Distribution Variance: This is a system hold. It indicates that the invoice header amount 
and the invoice distribution amounts do not agree. Query the payment voucher in IS and 
make changes to either the header or distribution form, then approve the transaction.  
  
Resubmit PV: This hold indicates Procurement originally returned the payment voucher to 
the department. After supplying requested information, the user checked “Resubmit PV” on 

the approval screen in the Integrated System. If you feel you have supplied all required 
information and this hold does not seem to be released, please contact Procurement 
Services immediately.  
  

  
Procurement Services will handle all other holds.  No user action is required 

unless requested. 

Procedure 

 
Begin by locating the payment voucher that requires changing. (Refer to the Finding and 

Reviewing a Payment Voucher topic.) 

 

Note: If you are changing the dollar amount of the payment voucher, then first work with the 

Discard Lines button and Distributions.  

 

In this simulation, Accounts Payable has rejected your payment voucher because of an incorrect 

expenditure type. Change and resubmit the payment voucher to Accounts Payable. 
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Step Action 

1. Step 1: View the Reason for Rejection 

 

Within the Payment Voucher, view the reason(s) Accounts Payable rejected it. 

 

Click the attachment (paperclip) icon. 

 

 

 
 

Step Action 

2. The Attachments screen displays. When you click in the Category field, the notes 

display.  

 

In this example, the first entry (Main Seq 10) contains the note you wrote when 

completing the payment voucher. 

 

The second entry (Main Seq 20) indicates a wrong expenditure type was used. 

 

Click in the Category field.  

 

3. The attached note displays. 
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Step Action 

4. Now you can correct the payment voucher. 

 

Click the Close button. 

 

 

 
 

Step Action 

5. Step 2: Correct the Payment Voucher 

 

Since in this example the expenditure type needs to be changed, first review the 

original PTAEO information. 

 

Click the All Distributions button. 
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Step Action 

6. To view the fields on the right, click the horizontal scrollbar. 

7. The PTAEO information displays. 

 

Click the Close button. 
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Step Action 

8. Next, reverse the original PTAEO information. 

 

Click the 2 Lines tab. 

 

9. Click the Discard Line 1 button. 

 

10. Notice that the amount for line 1 is now a zero dollar amount. 

 

You will re-enter the dollar amount (on the next available line). 

11. Click in the Amount field.   

 

12. Enter the desired information into the Amount field. Enter "500.00". 

13. Enter the correct PTAEO information, including the new expenditure type.  

 

Click the Distributions button. 
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Step Action 

14. Click in the Amount field. 

 

15. Enter the desired information into the Amount field. Enter "500.00". 

16. Click in the Project field. 

 

17. Enter the desired information into the Project field. Enter "101902". 

18. Press [Tab]. 

19. Enter the desired information into the Task field. Enter "101". 

20. Press [Tab]. 

21. Enter the desired information into the Award Number field. Enter "LG00005". 

22. Press [Tab]. 

23. You can search for an expenditure type. 

 

Click on the Expenditure Type... button. 

 

24. The LOV displays.  

 

Click in the Find field. 

25. Enter the desired information into the Find field. Enter "Honoraria%". 

26. Click the Find button. 

 

27. The expenditure type populates the field. 

 

Press [Tab]. 

28. Enter "20030" into the Expenditure Organization field. 

29. Press [Tab]. 

30. Save your changes. 

 

Click the Save button. 

 

31. Click the Close button. 
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Step Action 

32. Write a note to Accounts Payable by clicking the attachment (paperclip) icon. 

 

 

 
 



Training Guide 

 
 

 

 Page 334 

Step Action 

33. Click in the next available Category field. 

 

34. You can use shortcuts to enter the category. 

 

Enter "m" into the Category field. 

35. Press [Tab]. 

36. Enter text in either the Title and/or Description fields. 

 

For this example, enter "Corrected exp type" into the Title field. 

37. Press [Tab]. 

38. From the Source tab, enter the Data Type. 

 

Click the Data Type... button. 

 

39. Choose from the LOV. For this exercise, choose Short Text. 

 

Click the Short Text list item. 

 

40. Click the OK button. 

 

41. Write a short text note.   

 

In this example, a note has been entered for you. 

42. Save your entry. 

 

Click the Save button. 

 

43. Click the Close button. 
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Step Action 

44. Step 3: Resubmit the Payment Voucher 

 

Click the Actions... 1 button. 

 

45. If needed, you may select multiple Payment Voucher Actions checkboxes. 

 

However, if both the All Approvals Have Been Approved and the Resubmit to 

Accounts Payable buttons are selected, then the system generates the following 

note."The Fiscal Classification Code is not associated with any Item Category 

Code". Click OK and the note will go away. 

 

Important: When resubmitting a payment voucher to Accounts Payable, do not 

select the All Approvals Have Been Obtained button. 
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Step Action 

46. Click the Resubmit to Accounts Payable checkbox only.  

 

47. Click the OK button. 
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Step Action 

48. A note displays.  

 

Click the OK button. 

 

49. The next note informs you that the payment voucher is awaiting Accounts Payable's 

review.   

 

Click the OK button. 

 

50. To view the status of the payment voucher, click the 1 General tab. 

 

51. The Status section displays the information that the status of the payment voucher is 

Needs Revalidation, and that there is one Hold placed on it.    

 

If the requested changes have been completed and they do not require additional 

information or further changes, Accounts Payable will review the payment voucher, 

release the hold, and process the payment. 

52. Congratulations! You have completed the simulation for changing and resubmitting 

a payment voucher. 

End of Procedure. 

Canceling a Payment Voucher 

After creating a payment voucher you may find that you need to cancel it.   
  
You can cancel a payment voucher if the payment voucher status is Validated and it has 
not been paid.  

  
Check the status of the payment voucher to determine if it has been paid BEFORE you 
attempt to cancel it.  

• To verify that the payment voucher (invoice) has not been paid, use Invoice 
Overview. Navigate to Accounts Payable: Invoices: Inquiry>Invoice Overview to 
determine the status of the payment voucher.   

  

Procedure 

 
In this simulation you will cancel a payment voucher. 
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Step Action 

1. First, search for the payment voucher to be canceled by clicking the Flashlight icon. 

 

Another method is to select View>Find from the menu bar. 
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Step Action 

2. Click in the Voucher Audit: Numbers: Start field. 

 

3. Enter the desired information into the Voucher Audit: Numbers: Start field. Enter 

"2367369". 

4. Press [Tab]. 

5. The voucher number automatically populates the Voucher Audit: Numbers: 

End field. 

 

Click the Find button. 

 

 

 
 

Step Action 

6. The Payment Voucher displays. 

 

Reverse the original information. 

 

Click the 2 Lines tab. 
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Step Action 

7. Click the Discard Line 1 button. 

 

8. Click the 1 General tab. 

 

9. Review the new distribution lines. 

 

Click the All Distributions button. 

 

10. The Distribution Total is now zero (0). 

 

Next you will change the Invoice Total to equal the Distribution Total (zero). 
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Step Action 

11. Click the Close button. 
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Step Action 

12. Refresh the page by re-querying the payment voucher.   

 

Click the Flashlight icon. 

 

 

 
 

Step Action 

13. Re-enter the Voucher Audit: Start and End Numbers. 

 

In this example, the numbers have been entered for you. 

 

Click on the Find button. 
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Step Action 

14. The Payment Voucher form displays. Next, change the invoice amount to zero. 

 

Click in the Invoice Amount field. 

 

 

15. Enter the desired information into the Invoice Amount field. 

 

Enter "0".  

 

16. Save your changes. 

 

Click the Save button. 

 

17. Write a note to Accounts Payable concerning your actions. 

 

Click the Attachments (paperclip) icon. 

 

(If this action results in a Java Security Warning dialog box, click Yes.)   

 

18. Enter the category and a title and/or description. 

 

In this example, the fields have been completed for you. 
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Step Action 

19. Choose a data type and enter information, then save your work. 

 

In this example, a short text message has been entered for you. 

 

 
 

Step Action 

20. Click the Close button. 
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Step Action 

21. Finally, resubmit the voucher. 

 

Click the Actions... 1 button. 
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Step Action 

22. Check the Resubmit to Accounts Payable box. 

 

23. Click the OK button. 

 

24. The payment voucher displays a zero (0) invoice amount and a zero (0) distribution 

amount. 

 

Important Note: Complete and submit an Invoice Correction form (Procurement 

and Supplier Diversity Services website) to inform Accounts Payable of the 

cancellation. 

25. Congratulations! You have completed the simulation for canceling a payment 

voucher. 

End of Procedure. 

Working with the Document Tab on the Navigator 

What is it?  

  

Saving a document to the Navigator is like having your personal "pending" clipboard 

within the Integrated System. This functionality allows you to create a Payment 

Voucher, enter the distribution(s), save the Payment Voucher and place it on "hold" 

until you are ready to submit it. This is a manual process. You are the only one who 

can view documents stored on your Navigator tab. The Navigator tab can hold 99 

documents.  

  

When would you use it?  

  

Use this functionality if you create a multitude of Payment Vouchers, are constantly 

waiting for supporting documentation from your staff, or during Fiscal Year End (the 

Actions... 1 button is not available).  

  

  

Important notes:   

• Payment Vouchers are not paid until you have approved them using the 

Actions... 1 button!  

• Use this functionality only for Payment Vouchers in the purchasing module.   

• It is not mandatory that you use this optional system functionality.   
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Saving a Document to the Navigator 

Procedure 

 
Saving a document to the Navigator is like having your personal "pending" clipboard within the 

Integrated System. The payment voucher is on "hold" until you are ready to complete it. This is a 

manual process.  

 

In this simulation you will save a payment voucher to the Navigator, rename and open it to 

approve and submit it to Accounts Payable.  

 
 

Step Action 

1. For this example, you have entered the payment voucher and the distributions 

information. 

 

Click the File menu. 

 

 or Press [Alt+F]. 

2. Click once on the Place on Navigator list item.  

 

Note: Multiple clicks will result in multiple copies of the same Payment Voucher 

stored on the Navigator. 

 

 or Press [G]. 
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Step Action 

3. Close the payment voucher. 

 

Click the Close button. 

 

 

 
 

Step Action 

4. You are working in the Documents tab of the Navigator - UVA PO Purchaser. This 

is where you can find any saved payment vouchers.   

 

Click the Functions tab to see where you are in the Integrated System.  

 

5. Click the Documents tab to work with your saved payment voucher. 

 

6. Renaming a Document 

 

It is important that you can easily identify each voucher. Next you will rename the 

payment voucher.  

 

Click in the Document name box. 
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Step Action 

7. Click the Rename button. 

 

 or Press [Alt+R]. 

8. Click in the New Label field. 

 

9. Press [Delete]. 

10. Enter the desired information into the New Label field.  

 

Enter "Marbury reimb". 

11. Click the OK button. 

 

12. There are two ways to view the documents list; Icon view or List view. You decide 

which view you would like to use.  

 

Click the List view radio button. 

 

13. The documents are now in a list format. 

 

Click the Icon view radio button to return to the previous view. 

 

14. Opening and Reviewing a Payment Voucher 

 

Double-click the icon of the payment voucher you wish to review. 

 

Double-click the Marbury reimb icon. 
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Step Action 

15. The Payment Voucher opens. Review the voucher for completeness. 

 

If you did not enter the distribution(PTAEO) before placing the document on the 

Navigator, then enter it from the Lines tab. 

 

For this example, the PTAEO was entered and you wish to review it again before 

submitting the voucher.  

 

Click the All Distributions button. 

 

 or Press [Alt+S]. 
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Step Action 

16. Review the distribution(s). If changes are needed, you cannot make them here. 

Instead, exit this screen and use the Lines tab to correct the PTAEO information. 

 

For this example, no changes are needed. 

 

Click the Close button. 
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Step Action 

17. You are ready to approve the payment voucher and submit it to Accounts Payable. 

 

Click the Actions... 1 button. 

 

 or Press [Alt+C]. 
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Step Action 

18. Click the All Approvals Have Been Obtained radio button.  

 

Note: You may select other buttons as needed. 

 

19. Click the OK button. 

 

 or Press [Alt+O]. 
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Step Action 

20. Read and respond as needed to any other system generated Notes.  

 

Click the OK button. 

 

 or Press [Alt+O]. 

21. The payment voucher status is Validated. 

 

Next, you will return to the Navigator to manually remove the saved payment 

voucher.  

22. Click the Close button. 
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Step Action 

23. Removing a Payment Voucher 

 

Click the icon of the Marbury reimb payment voucher. 

 

24. Click the Remove button. 

 

 or Press [Alt+M]. 

25. Click the OK button. 

 

 or Press [Alt+O]. 

26. The payment voucher is no longer accessible on the Navigator Documents tab. 

However, you may still view it by following the instructions found in the topic 

"Finding and Reviewing a Payment Voucher". 

27. Congratulations! You have successfully saved a Payment Voucher to the Navigator, 

renamed and opened it, as well as approved and submitted it to Accounts Payable. 

End of Procedure. 

 

 


